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Workshop Introduction

Workshop Introduction

C2000 Microcontroller 1-Day Workshop

Texas Instruments
Technical Training

13 TEXAS
INSTRUMENTS  C2000 is trademarks of Texas Instruments. Copyright © 2012 Texas Instruments. Al rights reserved.

C2000 MCU 1-Day Workshop Outline

& Workshop Introduction
& Architecture Overview

¢ Programming Development Environment
¢ Lab: Linker command file

¢ Peripheral Register Header Files

¢ Reset, Interrupts and System Initialization
¢ Lab: Watchdog and interrupts

¢ Control Peripherals
¢ Lab: Generate and graph a PWM waveform

¢ Flash Programmin
¢ Lab: Run the code from tlash memory

¢ The Next Step...

4 C2000 MCU 1-Day Workshop



Workshop Introduction

Required Workshop Materials

& http://processors.wiki.ti.com/index.php/

C2000_Piccolo_One-
Day Workshop Home_ Page

¢ F28069 controlSTICK kit
¢ Install Code Composer Studio v5.1.1

¢ Run the workshop installer
C2000 Microcontroller 1-Day Workshop-4.0-Setup.exe

&Lab Files / Solution Files

oStudent Guide and Documentation

Tl Embedded Processing Portfolio

Tl Embedded Processors

Digital Signal Processors (DSPs) |

| Microcontrollers (MCUs) | | ARM®-Based Processors | |
16-bit ultra- 32-hit 32-bit ARM ARM - Ultra
low power real-time Cortex™-M3 Cortex-A8 DSF[') i-S:RM Muglsgore Low power
MCUs MCUs MCUs MPUs DSP
( [ c2000m ) ( Stellari o \( sitara” ) c6000™ (" HYe -
mMsP430™ || Delfino™ ||  SteUaN® 1| smmeconexwas || DaVinci €6000 €5000
Piccolo"" & ARM9 video procﬁTﬁors
OMAP 24.000
Up to 40MHZ to Up to 300MHz to 00MHz to >1Ghz MMACS Up to 300 MHz
25 MHz 300 MHz 100 WHz >1GHz +Accelerator +Accelerator
Flash Flash, RAM Flash Cache, Ceche Cache Upto 320KE RAM
1 KBto256 KB || 16KBI0SIZKE || SKBto256KE RAM, ROM RAM, ROM RAM ROM Upto 128KB ROM
Analog 110, ADC PYIM ADC, USE, ENET USE, CAN, USB, ENET, SRIC, EMAC USB, ADC
LCD, USE, RF CAN, 8PI FC %%*PPWF\E@% FCle, EMAC PCle, SATA, SPI DI, PCle MEBSP, SPI, [EC
IMeasure mert, Iator Gontrol, onnectivity, Security Industrial computing, || Fleating/Fixed Point Telecom T&M Audio, Woice
Sensing, General Digital Power, Whtion Control, HML| | FOS & portable Wideo, Audio, Voice, | [ media gatewsys, . .
Purpose Lighting, Ren. Eny | ndustrial Autormation data terminals Security Gonfer bese stations Medical, Biometrics
s < e B[N
VAN N A N N\

N VAN m—
- =3 Software & Development Tools _
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Workshop Introduction

C2000™ - Building Upon 3 Brands

Piccolo™MC Delfino™MCUs Concerto™ MCUs

F28M35x

Performance: Performance: Performance:
40-80MHz 28x CPU 100-300MHz 28x CPU Dual Core
Floating Point Unit (optional) Floating Point Unit Up to 150MHz 28x CPU
CLA Co-Processor (optional) Memory: Up to 100MHz ARM Cortex M3 CPU
VCU Accelerator (optional) Unt 512K|;y|5| h Floating Point Unit
M . RS as VCU Accelerator
emory: Up to 516KB SRAM M
16KB-128KB Flash : . emory:
6KB-L00KB SRAM ADCKS%hPAenpherals. 256KB-AMB Fiash
) , PWM, QEP, DMA, SP!, Up to 132KB SRAM
Key Peripherals: UART, I2C, CAN, EMIF )
ADC, PWM, QEP, DMA, SPI, o Key Peripherals:

ADC, PWM, QEP, DMA, EMIF, SPI,

N

g
176 QFP, 176 BGA, 179 u*BGA,

UART, I2C, CAN, USB

Solar Power inverters o White Goods 1nyycrrial Drives -
g & Motion Control

Digital Power i
LED StreetLighting

.| Uninterruptable

Power Supplies
Backiighting

Telecom / Server
AC/DC Rectifiers Radar/ Coll

Avoidance
Smart Metering

Hybrid Electric Vehicles '
Power L ine
Communication RF

Communication

Smart Grid & PLC
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C2000 Delfino / Piccolo Comparison

F2833x F2803x F2806x
Clock 150 MHz 60 MHz 80 MHz
Flash / RAM 128Kw / 34Kw 64Kw / 10Kw 128Kw / 50Kw
On-chip Oscillators 2 2
VREG / POR/BOR v v
Watchdog Timer v v v
12-bit ADC SEQ - based SOC - based SOC - based
Analog COMP w/ DAC v v
FPU v v
6-Channel DMA v - v
CLA v v
VCU - - v
ePWM/HR ePWM viIiv vIv vIiv
eCAP / HR eCAP - - viv
eQEP v v v
SCI/SPI/12C v v v
LIN - v -
McBSP v v
USB - v
External Interface v

TMS320F28069 controlSTICK

On-board USB
JTAG Emulation

LED LD2
(GPIO34)

=
=
E
E|
= |

TMS320F28069

USB JTAG
Interface & Power

LED LD1
(Power)

Peripheral
Header Pins

C2000 MCU 1-Day Workshop 7



Architecture Overview

Architecture Overview
TMS320F2806x Block Diagram

Program Bus

i Sectored L >
RAM 6 Ch
Flash -
DMA Bus ‘é
CLA Bus
. . ———
2 l PIE
32-bit R-M-W Interrupt
32x32 bit FPU
Auxitiary || 77 " || Atomic cLa| |Manager
i Multiplier VCU
Registers, ALU 5
[ 32:bit _
Register Bus Timers

CPU

Data Bus

TMS320F28069 Memory Map

Dat P
0Xx000000 ala_| Program .
OX000400 | MO SARAM (1Kw) :
M1 SARAM (1Kw) 0x014000 reserved
0x000800 0x3D7800
0x000D00 5iE Vectors | 0x3D7C00 = CILE G
(256 w) i reserved
OX000800 1 | Teserved Ox3D7C80T, 057 0SC cal. dat
0x002000 (GKkw 0x3D7CCO CZ' il
reserve
gxggzggg PF 3 (4Kw) 0x3D8000
X PF 1 (4Kw) FLASH (128Kw)
0007000 557 aicw) OX3F7FF8
X
Ox008000 1= 0 o am (2Kw) 0x3F8000- e e
0x008800
OX008CO0 | L1 DPSARAM (1Kw) Boot ROM (32Kw)
0x009000 {—2DPSARAN (Kw) OX3FFFCO
0X00A000 L3 DPSARAM (4Kw) Ox3FFFFF BROM Vectors (64w)
L4 SARAM (8Kw) Data | Program
O0x00C000 1= o RAM (8Kw)
w
gxgggggg L6 DPSARAM (8Kw) DPSARAM LO, L1, L2 & L3| CSM Protected:
X accessible by CPU & CLA| LO,L1,L2, L3, L4,
012000 |7 DPSARAM (8Kw) OTP, FLASH,
L8 DPSARAM (8Kw) DPSARAM L5, L6, L7 & L8 ADC CAL,
0x014000 R accessible by DMA Flash Regs in PFO
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Architecture Overview

F28x Fast Interrupt Response Manager

¢ 96 dedicated PIE

vectors
& No software decision |s PIE mocule ,
making required cl‘lo G 28x CPU Interrupt logic
. & INTL to
& Direct access to RAM | P
0
v r 5:|'> :: > 28
AE(itOﬂS dat g 96 PIE 12 interrupts IFR || 1IER || iInTM CP>L(J
¢ Auto flags update £ o
¢ Concurrent auto g Map
<
context save =
a

Auto Context Save
T STO

AH AL

PH PL

AR1 (L) | ARO (L)
DP ST1
DBSTAT | IER
PC(msw)| PC(Isw)

Direct Memory Access (DMA)

i PIE i
i DINTCH1-6 :
ADC ittty f ------ '
H
Result 0-15 McBSP-A
ﬁ 4
DMA SysCtrIRegs.EPWMCNF.bit. CONCNF
L5 DPSARAM |G— 6-channels (map}s ePWM to DMA bus or CLA bus)
Triggers i PWM1 b—
L6 DPSARAM |«== 1 PWNI2
BT e A —
—
L7 DPSARAM <= XINT1-3 / TINTO-2 BVUVE
ePWM1-6 (SOCA-B)
USBOEP1-3RX/TX PWM6 ——
L8 DPSARAM | software

Transfers data between peripherals and/or
memory without intervention from the CPU
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Architecture Overview

Control Law Accelerator (CLA)

ADC C28x CPU
& PWM
CMP CLA

AVAVAVAVS I—_r

UL
HIH

¢ CLA is an independent 32-bit floating-point
math accelerator

¢ Executes algorithms independently and in
parallel with the main CPU

¢ Direct access to ePWM / HRPWM, eCAP, eQEP,
ADC result and comparator registers

¢ Responds to peripheral interrupts
independently of CPU

& Frees-up CPU for other tasks
(communications and diagnostics)

Viterbi, Complex Math, CRC Unit (VCU)

Extends C28x instruction set to support:

< Viterbi operations
& Decode for communications

¢ Complex math

& 16-bit fixed-point complex FFT (5 cycle butterfly)

+ used in spread spectrum communications, and many signal processing
algorithms

¢ Complex filters

+ used to improve data reliability, transmission distance, and power
efficiency

¢ Power Line Communications (PLC) and radar
applications

¢ Cyclic Redundancy Check (CRC)
¢ Communications and memory robustness checks

10 C2000 MCU 1-Day Workshop



Architecture Overview

Architecture Summary

¢ High performance 32-bit CPU

¢ 32x32 bit or dual 16x16 bit MAC

¢ |[EEE single-precision floating point unit (FPU)
¢ Hardware Control Law Accelerator (CLA)
< Viterbi, complex math, CRC unit (VCU)

& Atomic read-modify-write instructions

¢ Fast interrupt response manager

¢ 128Kw on-chip flash memory

¢ Code security module (CSM)

¢ Control peripherals

¢ 12-bit ADC module

¢ Comparators

& Direct memory access (DMA)

¢ Up to 54 shared GPIO pins

¢ Communications peripherals

C2000 MCU 1-Day Workshop 11



Programming Development Environment

Programming Development Environment

Code Composer Studio

Code Composer Studio: IDE

& CCS Edit - Code Composer Studio
File Edit View MNavigate Project Run Scripts Window Help

S~ K~ - ¥ ~ = B % CCSDebug | [ CCs Edit
L Project Explorer £3 B s =0 )
s ) Ind , l ¢ Integrates: edit, code generation,

and debug

¢ Single-click access using buttons

e et + Powerful graphing/profiling tools

6x_GlobalvariableDefs.c

6x_Headers_nonBIOS.cmd

¢ Automated tasks using Scripts

& Built-in access to BIOS functions

O I = = = =~ I = S O O - =

¢ Based on the Eclipse open source
software framework

Edit and Debug Perspective (CCSv5)

¢ Each perspective provides a set of functionality aimed
at accomplishing a specific task

¢ Edit Perspective ¢ Debug Perspective

+ Displays views used + Displays views used for
during code development debugging
+ C/C++ project, editor, etc. + Menus and toolbars

associated with debugging,
watch and memory
windows, graphs, etc.

12 C2000 MCU 1-Day Workshop



Programming Development Environment

CCSv5 Project

File Edit View Navigate Project Run Scrip Project ﬁles Contain:

it N P

Cimsteseal 57 "0 | ¢ List of files:
A4 Fxample [Active - Debug]
% ) Incudes + Source (C, assembly)
B g Adc.c
# (S CodeStartBranch.asm + Libraries
- |c| Defaultlsr.c
B (8] Delayus.asm + BIOS configuration file
[ ] ap.c
& ¢ Linker command files
! ¢ Project settings:
ey + Build options (compiler,
& assembler, linker, and BIOS)
@ (@ Pectl.c + Build configurations
+- || Pievect.c
* 1L SysCtrl.c
B €] Watchdog.c

Creating a New CCSv5 Project

+ File 2 New - CCS Project

1. Project Name, Location, and Device

2 Advanced Seftings

. w Advanced settings
CCS Project i

Create a new CCS Project / — Device endianness:

Compiler version; TIv6.0.2 v
Project name: | Example TrTaiT oo

More,
Linker command file: v
[use default location
Runtime support library: | <automatic> B [ 6rowee...
Location: | C:\C28x\Lsbs\Exampie Brovsse.... T e rowse

Output type; |Exacutsble v

Device
fote a0 hd 3. Project Templates and Examples
Variant: 2806x Piccolo ¥ | |confrolSTICK - Piccolo F28069 W
w Project templates and examples
Connection: v
» Advanced settings = Empty Projects

& Emoty Project
b Project templates and examoles = . -
= Empty Assembly-only Project
= Empty RTSC Project
= [E] Basic Examples
& Hello World
# {=] DSP/BIOS v5,xx Examples

) Examples

@

C2000 MCU 1-Day Workshop 13



Programming Development Environment

1]

CCSv5 Build Options —

+ Compiler
+ 18 categories for code
generation tools
¢ Controls many aspects of
the build process, such as:
+ Optimization level
& Target device

& Compiler [ assembly / link
options

¢ Linker

+ 9 categories for linking
+ Specify various link
options

+ 3{PROJECT_ROOT}
specifies the current
project directory

Linking Sections in Memory

Sections

Global vars (.ebss) Init values (.cinit)

void main(void)
{

’,,Iong zZ;

Z =X tYVy,; v...

Local vars (.stack)  Code (.text)

& All code consists of
different parts called
sections

¢ All default section
names begin with “.”

¢ The compiler has
default section names
for initialized and
uninitialized sections

14
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Programming Development Environment

Compiler Section Names

Initialized Sections

Name Description Link Location

text code FLASH

.cinit initialization values for FLASH
global and static variables

.econst constants (e.g. const int k = 3;) FLASH

.switch tables for switch statements FLASH

.pinit tables for global constructors (C++) | FLASH

Uninitialized Sections

Name Description Link Location
.ebss global and static variables RAM

.stack stack space low 64Kw RAM
.esysmem | memory for far malloc functions RAM

Note: During development initialized sections could be linked to RAM since
the emulator can be used to load the RAM

Placing Sections in Memory

0x00 0000

0x00 0400

O0x3E 8000

Memory .
Sections
MOSARAM -
(0x400) | "7 .ebss
M1SARAM .
(0x400) Te~ea
7 .stack
FLASH e=====—""""] cinit
(0x10000) - -
Bt text

C2000 MCU 1-Day Workshop
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Programming Development Environment

Linking

e Memory description
e How to place s/w into h/w

Link.cmd

.0bj —— Linker — .out

.map

MEMORY
PAGE O: /* Program Memory */
FLASH: origin = Ox3E8000, length = 0x10000
PAGE 1: /* Data Memory */
MOSARAM: origin = 0x000000, length = 0x400
M1SARAM: origin = 0x000400, length = 0x400
}
SECTIONS
{
.text:> FLASH PAGE = O
.ebss:> MOSARAM PAGE = 1
.cinit:> FLASH PAGE = O
.stack:> M1SARAM PAGE = 1
by

Linker Command File

16
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Lab 1: Linker Command File

Lab 1: Linker Command File
» Objective

Use a linker command file to link the C program file (Labl.c) into the system described below.

Lab 1: Linker Command File

0x00 0000[ MOSARAM 0x00 AOOO|[ L4SARAM
Memory (0x400) (0x2000)

: 0x00 0400[ M1SARAM | 0x00 CO0O0[L5DPSARAM
on-chip (0x400) (0x2000)
memory 0x00 8000 [LODPSARAM| 0x00 EOOO[L6DPSARAM

(0x800) (0x2000)
0x00 8800 [L1DPSARAM| 0x01 0000[L7DPSARAM
F28069 (0x400) (0x2000)
0x00 8CO0[L2DPSARAM]| 0x01 2000[L8DPSARAM
Svyst D intion: (0x400) (0x2000)
ystiem Description. 0x00 9000 [L3DPSARAM
*» TMS320F28069 (0x1000)

« All internal RAM
blocks allocated
Placement of Sections:
« .text into RAM Block L4ASARAM on PAGE 0 (program memory)
e .cinit into RAM Block LASARAM on PAGE 0 (program memory)
« .ebss into RAM Block MOSARAM on PAGE 1 (data memory)
« .stack into RAM Block M1SARAM on PAGE 1 (data memory)

System Description
e TMS320F28069

e All internal RAM blocks allocated

Placement of Sections:
e .text into RAM Block LOSARAM on PAGE 0 (program memory)

e _cinitinto RAM Block LOSARAM on PAGE 0 (program memory)
e .ebss into RAM Block MOSARAM on PAGE 1 (data memory)
e stack into RAM Block M1SARAM on PAGE 1 (data memory)

> Procedure

Start Code Composer Studio and Open a Workspace

1. Start Code Composer Studio (CCS) by double clicking the icon on the desktop or
selecting it from the Windows Start menu. When CCS loads, a dialog box will prompt
you for the location of a workspace folder. Use the default location for the workspace
and click OK.

C2000 MCU 1-Day Workshop 17



Lab 1: Linker Command File

This folder contains all CCS custom settings, which includes project settings and views
when CCS is closed so that the same projects and settings will be available when CCS is
opened again. The workspace is saved automatically when CCS is closed.

The first time CCS opens a “Welcome to Code Composer Studio v5” page appears.
Close the page by clicking the X on the “T1l Resource Explorer” tab. You should now
have an empty workbench. The term workbench refers to the desktop development
environment. Maximize CCS to fill your screen.

The workbench will open in the “CCS Edit Perspective” view. Notice the CCS Edit
icon in the upper right-hand corner. A perspective defines the initial layout views of the
workbench windows, toolbars, and menus which are appropriate for a specific type of
task (i.e. code development or debugging). This minimizes clutter to the user interface.
The “CCS Edit Perspective” is used to create or build C/C++ projects. A “CCS Debug
Perspective” view will automatically be enabled when the debug session is started. This
perspective is used for debugging C/C++ projects.

Setup Target Configuration

3. Open the emulator target configuration dialog box. On the menu bar click:

File > New - Target Configuration File

In the file name field type F28069_ctrISTK.ccxml. This is just a descriptive name since
multiple target configuration files can be created. Leave the “Use shared location” box
checked and select Finish.

In the next window that appears, select the emulator using the “Connection” pull-down
list and choose “Texas Instruments XDS100vl USB Emulator”. Inthe
“Board or Device” box type F28069 to filter the options. In the box below, check the
box to select “controlSTICK — Piccolo F28069”. Click Save to save the
configuration, then close the “F28069_ctrISTK.ccxml” setup window by clicking the X
on the tab.

To view the target configurations, click:
View > Target Configurations

and click the plus sign (+) to the left of User Defined. Notice that the
F28069_ctriISTK.ccxml file is listed and set as the default. If it is not set as the
default, right-click on the .ccxml file and select “Set as Default”. Close the Target
Configurations window by clicking the X on the tab.

Create a New Project

6. A project contains all the files you will need to develop an executable output file (.out)

which can be run on the MCU hardware. To create a new project click:
File > New - CCS Project

In the Project name field type Labl. Uncheck the “Use default location” box. Click the
Browse... button and navigate to:

C:\C28x\Labs\Labl\Project

18
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Lab 1: Linker Command File

Click OK.

7. The next section selects the device. Select the “Family” using the pull-down list and
choose “C2000”. Set the “Variant” filter using the pull-down list to “2806x
Piccolo” and choose the “controlSTICK — Piccolo F28069”. Leave the
“Connection” box blank. We have already set up the target configuration.

8. Next, open the “Advanced setting” section and set the “Linker command file” to
“<none>". We will be using our own linker command file, rather than the one supplied
by CCS. Leave the “Runtime Support Library” set to “<automatic>". This will
automatically select the “rts2800_fpu32.lib” runtime support library for floating-point
devices.

9. Now open the “Project templetes and examples” section and select the very top “Empty
Project” template. (Note: Do not select the second one from the top - this option will
create an empty main.c file in the project, which is not needed for this lab exercise).
Click Finish.

10. A new project has now been created. Notice the Project Explorer window
contains Labl1. The project is set Active and the output files will be located in the
Debug folder. At this point, the project does not include any source files. The next step
is to add the source files to the project.

11. To add the source files to the project, right-click on Labl in the Project Explorer
window and select:
Add Files..

orclick: Project > Add Files..

and make sure you’re looking in C:\C28x\Labs\Lab1\Files. With the “files of
type” set to view all files (*.*) select Labl.c and Labl.cmd then click OPEN. A “File
Operation” window will open, choose “Copy Tiles” and click OK. This will add the
files to the project.

12. Inthe Project Explorer window, click the plus sign (+) to the left of Labl and
notice that the files are listed.

Project Build Options

13. There are numerous build options in the project. Most default option settings are
sufficient for getting started. We will inspect a couple of the default options at this time.
Right-click on Labl in the Project Explorer window and select Properties or
click:

Project - Properties

14. A “Properties” window will open and in the section on the left under “Build” be sure that
the “C2000 Compiler” and “C2000 Linker” options are visible. Next, under “C2000
Linker” select the “Basic Options”. Notice that .out and .map files are being
specified. The .out file is the executable code that will be loaded into the MCU. The
.map file will contain a linker report showing memory usage and section addresses in
memory.

15. Next in the “Basic Options” set the Stack Size to 0x200.

C2000 MCU 1-Day Workshop 19



Lab 1: Linker Command File

16.

Under “C2000 Compiler” select the “Processor Options”. Notice the “Use large
memory model” and “Unified memory” boxes are checked. Next, notice the “Specify
CLA support” is set to claO, the “Specify floating point support” is set to fpu32, and
the “Specify VCU support” is set to vcuO. Select OK to save and close the Properties
window.

Linker Command File — Labl.cmd

17.

18.

Open and inspect Labl . cmd by double clicking on the filename in the project window.
Notice that the Memory{} declaration describes the system memory shown on the
“Labl: Linker Command File” slide in the objective section of this lab exercise.
Memory blocks L3DPSARAM and LASARAM have been placed in program memory on
page 0, and the other memory blocks have been placed in data memory on page 1.

In the Sections{} area notice that the sections defined on the slide have been “linked”
into the appropriate memories. Also, notice that a section called .reset has been allocated.
The .reset section is part of the rts2800_fpu32.lib and is not needed. By putting the
TYPE = DSECT modifier after its allocation the linker will ignore this section and not
allocate it. Close the inspected file.

Build and Load the Project

19.

20.

21.

22.
23.

Two buttons on the horizontal toolbar control code generation. Hover your mouse over
each button as you read the following descriptions:

R B
Button Name Description
1 Build Full build and link of all source files
2 Debug Automatically build, link, load and launch debug-session

Click the “Bui 1d” button and watch the tools run in the Console window. Check for
errors in the Problems window (we have deliberately put an error in Lab1.c). When
you get an error, you will see the error message in the Problems window. Expand the
problem by clicking on the plus sign (+) to the left of the “Errors”. Then simply double-
click the error message. The editor will automatically open to the source file containing
the error, with the code line highlighted with a question mark (?).

Fix the error by adding a semicolon at the end of the “z = x + y” statement. For

future knowledge, realize that a single code error can sometimes generate multiple error
messages at build time. This was not the case here.

Build the project again. There should be no errors this time.

CCS can automatically save modified source files, build the project, open the debug
perspective view, connect and download it to the target, and then run the program to the
beginning of the main function.

Click on the “Debug” button (green bug) or click Run - Debug.
Notice the CCS Debug icon in the upper right-hand corner indicating that we are now in

the “CCS Debug Perspective” view. The program ran through the C-environment
initialization routine in the rts2800_fpu32.lib and stopped at main() in Labl.c.

20

C2000 MCU 1-Day Workshop



Lab 1: Linker Command File

Debug Environment Windows

It is standard debug practice to watch local and global variables while debugging code. There
are various methods for doing this in Code Composer Studio. We will examine two of them
here: memory browser, and expressions.

24. Open a “Memory Browser” to view the global variable “z”.
Click: View - Memory Browser on the menu bar.

Type &z into the address field, select “Data” memory page, and then select Go. Note
that you must use the ampersand (meaning “address of””) when using a symbol in a
memory browser address box. Also note that CCS is case sensitive.

Set the properties format to “Hex 16 Bit — TI Style Hex” in the browser. This will give
you more viewable data in the browser. You can change the contents of any address in
the memory browser by double-clicking on its value. This is useful during debug.

25. Notice the “Variables” window automatically opened and the local variables x and y are
present. The variables window will always contain the local variables for the code
function currently being executed.

(Note that local variables actually live on the stack. You can also view local variables in
a memory browser by setting the address to “SP” after the code function has been
entered).

26. We can also add global variables to the “Expressions” window if desired. Let's add the
global variable “z”.

Click the “Expressions” tab at the top of the window. In the empty box in the
“Expression” column (Add new expression), type z and then enter. An ampersand is not
used here. The expressions window knows you are specifying a symbol. (Note that the
expressions window can be manually opened by clicking: View - Expressions on
the menu bar).

Check that the expressions window and memory browser both report the same value for
“z”. Trying changing the value in one window, and notice that the value also changes in
the other window.

Single-stepping the Code

27. Click the “Variables” tab at the top of the window to watch the local variables. Single-
step through main() by using the <F5> key (or you can use the Step Into button on
the horizontal toolbar). Check to see if the program is working as expected. What is the
value for “z” when you get to the end of the program?

Terminate Debug Session and Close Project

28. The Terminate button will terminate the active debug session, close the debugger and
return CCS to the “CCS Edit Perspective” view.

Click: Run = Terminate or use the Terminate icon: L
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Lab 1: Linker Command File

29. Next, close the project by right-clicking on Labl in the Project Explorer window
and select Close Project.

End of Exercise
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Peripheral Register Header Files

Peripheral Register Header Files

Traditional Approach to C Coding

#define ADCCTL1 (volatile unsigned int *)0x00007100

void main(void)

{
*ADCCTL1 = 0x1234; //write entire register
*ADCCTL1 |= 0x4000; //enable ADC module
3
Advantages - Simple, fast and easy to type

- Variable names exactly match register names (easy
to remember)

Disadvantages

Requires individual masks to be generated to
manipulate individual bits

- Cannot easily display bit fields in debugger window
- Will generate less efficient code in many cases

Structure Approach to C Coding

void main(void)

{
AdcRegs.ADCCTL1.all = 0x1234; //write entire register
AdcRegs.ADCCTL1.bit.ADCENABLE = 1; //enable ADC module

}

Advantages - Easy to manipulate individual bits

Watch window is amazing! (next slide)
Generates most efficient code (on C28x)

Can be difficult to remember the structure names
(Editor Auto Complete feature to the rescue!)

Disadvantages

- More to type (again, Editor Auto Complete feature
to the rescue)
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Peripheral Register Header Files

Built-in CCSv5 Register Window

4 Registers 3 i B
Name Value

Hik Core Registers

& i a0

"
W

® i aa
& compy
&% covpz
aa comes
& couTIMER
¥

=]

RESULT

kS

HEEEE®

#

+

&% ecana_Lam

¥4 ecana_MoTs

&4 ecana_moTo

&% eCaNA_MBX_CONTENT

E

®E

84y
¥ eer0

¥ mreart

*
i+
*
&
®

! Registers 3

Name

0

NTSEL 3N4
INTSELSNE

INTSEL NS
INTSELSN 10
OCPRICTL
\DCSAMPLEMODE
\DCINTSOCSH
DCINTSOCSEL2
DCSOCFLG1
DCSOCFRC1
DCSOCOVF1
ADCSOCOWFCIR1
ADCSOCOCTL

DCSOC 12CTL

Ox40E4
0x0001
0x0001
D0x0000
Ox0001
0x0000
0x0060
Ox0000
Dx0000
Ox0000
0x0000
0x0000
Ox0000
D0x0000
Ox0000
0x0000
0x0000
Ox0000
Ox0000
0x3306
0x0000
0x0000
0x0000
Ox0000
Ox0000
0x0000
0x0000
0x0000
Ox0000
0x0000
0x0000
0x0000

G{ Expressions 1
Expression
= (= AdcRegs
= (= ADCCTLL
0= all
= (= bit
)= TEMPCONY
0= VREFLOCONY
)= INTPULSEPOS
(<)= ADCREFSEL
9= rsvd1
()= ADCREFPWD

)= ADCBGPV

©)= ADCPWDN

09= ADCBSYCHN
ADCBSY

ADCINTFLG
ADCINTFLGCLR
ADCINTOVF
ADCINTOVFCLR
INTSELINZ
INTSEL3N4
INTSELSNG
INTSEL7NG
= INTSELON1O
vd3
= rsvd4
)= rsvdS
® (# SOCPRICTL
00+ rsvdE

*

HEEREEE

union ADCCTL1_REG
unsigned int
struct ADCCTL1_BITS

{unsigned ir

{unsigned i
{unsigned int:
{unsigned i
{unsigned ir
{unsigned int:9:
{unsigned
{unsigned ir
{unsigned int:2:
{unsigned i
{unsigned ir
union ADCCTL2_REG
unsigned int

unsigned int

union ADCINT_REG
union ADCINT_REG
union ADCINT_REG
union ADCINT_REG
union INTSEL IN2_REG
union INTSEL 344 _REG
union INTSELSNE_REG
union INTSEL7N8_REG
union INTSELON10_REG
unsigned int

unsigned int

unsioned int

union SOCPRICTL_REG
unsigned int

LR X Xdl

Address

0x00007110@Data
0x00007111@Data

24
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Peripheral Register Header Files

Structure Naming Conventions

¢ The F2806x header files define:
¢ All of the peripheral structures
¢ All of the register names
¢ All of the bit field names
# All of the register addresses

PeripheralName.RegisterName.all /I Access full 16 or 32-bit register
PeripheralName.RegisterName.half.LSW /I Access low 16-bits of 32-bit register
PeripheralName.RegisterName.half. MSW /I Access high 16-bits of 32-bit register

PeripheralName.RegisterName.bit.FieldName // Access specified bit fields of register

Notes: [1] “PeripheralName” are assigned by Tl and found in the F2806x header files.
They are a combination of capital and small letters (i.e. CpuTimerORegs).

[2] “RegisterName” are the same names as used in the data sheet.
They are always in capital letters (i.e. TCR, TIM, TPR,..).

[3] “FieldName” are the same names as used in the data sheet.
They are always in capital letters (i.e. POL, TOG, TSS,..).

Editor Auto Com: lete to the Rescue!
5 CCS Edit - Example/Adc.c - Code g@@]

File Edit View Navigste Project Run S o
TR TR F - g 0t [ %5 ccspebug | [ cosede
Le] =Ade.c B3 alle

Licensed Vinitable Smart Insert 32:35
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Peripheral Register Header Files

F2806x Header File Package

(http://www.ti.com, controlSUITE)

¢ Contains everything needed to use the
structure approach

¢ Defines all peripheral register bits and
register addresses

¢ Header file package includes:

¢ \doc

¢ \F2806x_headers\include - .h files

¢ \F2806x_headers\cmd - linker .cmd files
¢ \F2806x_common\gel
& \F2806x_examples

- .gel files for CCS
- code examples
- documentation

controlSUITE Header File Package located at C:\TI\controlSUITE\device_support\

Peripheral Structure .h files @of2

¢ Contain bits field structure definitions for each peripheral register

Your C-source file (e.g., Adc.c)
#include “F2806x_Device.h"

Void InitAdc(void)

AdcRegs.ADCCTL1.bit.RESET = 1;

/* configure the ADC register */
AdcRegs.ADCCTL1.all = 0x00E4;
b

{ Uintl6 ADCPWDN:1; /I'7 ADC powerdown
/* Reset the ADC module */ .
Uintl6 ADCBSYCHN:5;  //12:8 ADC busy on a channel

F2806x_Adc.h

/I ADC Individual Register Bit Definitions:

struct ADCCTL1_BITS { /' bits description
Uintl6 TEMPCONV:1; /I 0 Temperature sensor connection
Uintl6 VREFLOCONV:1; // 1 VSSA connection
Uintl6 INTPULSEPOS:1; // 2 INT pulse generation control
Uintl6 ADCREFSEL:1; // 3 Internal/external reference select
Uintl6 rsvdl:1; I/l 4 reserved
Uintl6 ADCREFPWD:1; // 5 Reference buffers powerdown
Uintl6 ADCBGPWD:1; /I 6 ADC bandgap powerdown

Uintl6 ADCBSY:1; /1 13 ADC busy signal
Uintl6 ADCENABLE:1; /1 14 ADC enable
Uintl6 RESET:1; /I 15 ADC master reset

b
/I Allow access to the bit fields or entire register:
union ADCCTL1_REG {

Uintl6 all;

struct ADCCTL1_BITS bit;
b
/I ADC External References & Function Declarations:
extern volatile struct ADC_REGS AdcRegs;

26
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Peripheral Register Header Files

Peripheral Structure .h files @or2

¢ The header file package contains a .h file for
each peripheral in the device

F2806x_Adc.h F2806x_BootVars.h F2806x_Cla.h
F2806x_Comp.h F2806x_CpuTimers.h F2806x_DevEmu.h
F2806x_Device.h F2806x_Dma.h F2806x_ECan.h
F2806x_ECap.h F2806x_EPwm.h F2806x_EQep.h
F2806x_Gpio.h F2806x_l2c.h F2806x_Mchbsp.h
F2806x_Nmilntrupt.h F2806x_PieCtrl.h F2806x_PieVect.h
F2806x_Sci.h F2806x_Spi.h F2806x_SysCtrl.h
F2806x_Usb.h F2806x_XIntrupt.h

¢ F2806x_Device.h
¢ Main include file
¢ Will include all other .h files
< Include this file (directly or indirectly)
in each source file:
#include “F2806x_Device.h”

Global Variable Definitions File
F2806x_GlobalVariableDefs.c

¢ Declares a global instantiation of the structure
for each peripheral

¢ Each structure is placed in its own section using
a DATA_SECTION pragma to allow linking to the
correct memory (see next slide)

F2806x_GlobalVariableDefs.c
#include "F2806x_Device.h"

#pragma DATA_SECTION(AdcRegs,"AdcRegsFile");
volatile struct ADC_REGS AdcRegs;

& Add this file to your CCS project:
F2806x_GlobalVariableDefs.c

C2000 MCU 1-Day Workshop 27



Peripheral Register Header Files

Linker Command Files for the Structures
F2806x_nonBIlOS.cmd and F2806x_BIOS.cmd

F2806x_GlobalVariableDefs.c

#include "F2806x_Device.h"

—~ #pragma DATA_SECTION(AdcRegs,"AdcRegsFile");
volatile struct ADC_REGS AdcRegs;

& Links each structure to
the address of the
peripheral using the
structures named
section

F2806x_Headers_nonBIlOS.cmd

& non-BIOS and BIOS
versions of the .cmd file

MEMORY
PAGEL: # Add one of these files to
ADC:  origin=0x007100, length=0x000080 your CCS project:
y F2806x_nonBlOS.cmd
SECTIONS or
t F2806x_BIOS.cmd
AdcRegsFile: > ADC PAGE = 1
L o
Peripheral Specific Examples
¢ Example projects for each peripheral
¢ Helpful to get you started
| adc_soc )eqep_pos_speed \(C)mcbsp_loopback_interrupts

() external_interrupt
) flash_f23069

(D) adc_temp_sensor
) adc_temp_sensor_conv

(D) da_adc ) fou_hardware
[ da_adc_fir 2 fou_software
) da_adc_fir_flash LD apio_setup
(D cpu_timer (L) apio_toggle

L) dma_ram_to_ram
(D) ecan_back2back

() hrcap_capture_hrpwm
(D hrcap_capture_pwm

[ ecap_apwm ) hrpwm

(D) ecap_capture_pwm L) brpwm_duty_sfo_vé

2 epwm_blanking_window i) hrpwm_mult_ch_prdupdov
(L) epwm_dcevent_trip ()hrpwm_prdup_sfo_vé
|[2)epwm_dcevent_trip_comp L) hrpwm_prdupdown_sfo_vé
|[)epwm_deadband ) hrpwm_slider

) epwm_real-time_interrupts L)i2c_eeprom

(L) epwm_timer_interrupts 2D Ipm_haltwake

() epwm_trip_zone ) lpm_idlewake

() epwm_up_aq (2 Ipm_standbywake

(D epwm_updown_aq [L)mcbsp_loopback

[ eqep_freqcs [C)mcbsp_loopback_dma

wn_sfo_vé

L) mcbsp_spi_loopback
LJ)osc_comp

) sci_echoback
J)scia_loopback

) scia_loopback_interrupts
)spi_loopback

() spi_loopback_interrupts
L)sw_prioritized_interrupts
) timed _led_blink
(Jusb_dev_bulk
Jusb_de
Jusb_dev_keyl
(Jusb_de
(D)usb_dev_serial
Jusb_host_keyboard
)usb_host_mouse
_Jusb_host_msc
)watchdog

=1
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Peripheral Register Header Files

¢ Easy to use

Peripheral Register Header Files
Summary
¢ Easier code development

& Generates most efficient code
¢ Increases effectiveness of CCS watch window

¢ Tl has already done all the work!
¢ Use the correct header file package for your device:

» F2806x
» F2803x
» F2802x
» F2833x and F2823x

* F280x and F2801x
* F2804x
* F281x

Go to http://lwww.ti.com and enter “controlSUITE” in the keyword search box

C2000 MCU 1-Day Workshop
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Reset, Interrupts and System Initialization

Reset, Interrupts and System Initialization

Reset

Reset Sources

Missing Clock Detect F28x core

Watchdog Timer

Power-on Reset

XRS
Brown-out Reset

XRS pin active

To XRS pin

Logic shown is functional representation, not actual implementation

. POR — Power-on Reset generates a device reset during
power-up conditions

. BOR — Brown-out Reset generates a device reset if the
power supply drops below specification for the device

Note: Devices support an on-chip voltage regulator (VREG) to
generate the core voltage

Reset — Bootloader

Reset Reset vector
OBJMODE = 0 ‘ fetched from Bootloader sets
AMODE = 0 boot ROM oEﬂ]Ah(ggll:E)IE—T)l
ENPIE=0 =
INTM = 1 0x3F FFCO
YES Emulator NO

TReT-1| Connected ? [TRs7-0

Emulation Boot Stand-alone Boot
Boot determined by Boot determined by
2 RAM locations: 2 GPIO pins and

EMU_KEY and EMU_BMODE 2 OTP locations:
OTP_KEY and OTP_BMODE

_ EMU_KEY & EMU_BMODE located in PIE at 0x0D00 & 0x0DO01, respectively
TRST = JTAG Test Reset 55 Ey & OTP BMODE located in OTP at 0x3D7BFB & Ox3D7BFE, respectively
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Reset, Interrupts and System Initialization

Emulatio

n Boot

Boot determined by

2 RAM locations:
EMU_KEY and EMU_BMODE

EMU_KEY = Ox55AA ? I

Boot Mode

Wait

Emulation Boot Mode (TrsT = 1)

Emulator Connected

If either EMU_KEY or EMU_BMODE
are invalid, the “wait” boot mode is
used. These values can then be
modified using the debugger and a
reset issued to restart the boot process

— OTP_KEY = 0x005A ? |

1 NO | Boot Mode

YES
EMU BMODE = | Boot Mode
0x0000 Parallel I/O
0x0001 SCI
0x0003 GetMode
0x0004 SPI
0x0005 12C
0x0006 OTP
0x0007 CAN
0x000A MO SARAM
0x000B FLASH
other Wait

FLASH
l YES
OTP_BMODE = | Boot Mode
0x0001 SCI
0x0004 SPI
0x0005 12C
0x0006 OTP
0x0007 CAN
other FLASH

Emulator Not

Connected

Stand-alo

ne Boot

2 GPIO p

Boot determined by

2 OTP locations:
OTP_KEY and OTP_BMODE

ins and

GPIO GPIO
37 34 Boot Mode
0 0 Parallel I/O
0 1 SCI
1 0 Wait
1 1 GetMode

Stand-Alone Boot Mode (TrRsT=0)

Note that the boot behavior for
unprogrammed OTP is the
“FLASH” boot mode

—{ OTP_KEY = 0x005A 7 |—— Bcl’:oLtA'\g%de
l YES
OTP_BMODE = | Boot Mode
0x0001 scl
0x0004 SPI
0x0005 12C
0x0006 oTP
0x0007 CAN
other FLASH
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Reset, Interrupts and System Initialization

Reset Code Flow - Summary
0x000000 0x000000
MO SARAM (1Kw)
0x3D7800 0x3D7800
OTP (1Kw)
0x3D8000 e
| FLASH (128Kw)
L Ox3F7FF6
0x3F8000 Boot ROM (32Kw) Execution Entry
E Ic;ggergrglggtdwtl)gde or [ 7]
mu
Boot C%?(EFFYSC Stand-Alone Boot Mode i
: : i !
1
BROM vector (84w) :
v
RESET ‘ Ox3FFFCO Ox3FF75C Bootloading
Routines
________________________ (SClI, SPI, 12C,
------------------------ CAN, Parallel 1/0)
Interrupts
Interrupt Sources
Internal Sources
TINT2
TINT1 F28x CORE
TINTO XRS
ePWM, eCAP, eQEP, PIE A
ADC, SCI, SPI, 12C, (Peripheral INT1
eCAN, McBSP, » te"r’rupt INT2
ik, Clksy, D Expansion) a INT3
External Sources ’
___________ INT12
XINT1 — XINT3 —i— INTLS
- ! INT14
TZx —
—_— |
XRS i

32
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Maskable Interrupt Processing

Conceptual Core Overview

Core (IFR) (IER) (INTM)
Interrupt  “Latch” “Switch” “Global Switch”
INT1 m—
Ntz ——{0}—~"- ' | F28x
. . . = | Core

¢ Avalid signal on a specific interrupt line causes the latch
to display a “1” in the appropriate bit

¢ If the individual and global switches are turned “on” the
interrupt reaches the core

Core Interrupt Registers

Interrupt Flag Register (IFR) (pending = 1/ absent = 0)
15 14 13 9

11 10 8
RTOSINT | DLOGINT | INT14 INT13 INT12 INT11 INT10 INT9
INT8 INT7 INT6 INT5 INT4 INT3 INT2 INT1
7 6 5 4 3 2 1 0
Interrupt Enable Register (IER) (enable = 1/ disable = 0)
15 14 13 12 u 10 9 8
RTOSINT | DLOGINT | INT14 INT13 INT12 INT11 INT10 INT9
INT8 INT7 INT6 INTS INT4 INT3 INT2 INT1
7 6 5 4 3 2 1 0
Interrupt Global Mask Bit (INTM Bit 0
ST1 INTM (enable = 0/ disable = 1)

/*** Interrupt Enable Register ***/
extern cregister volatile unsigned int IER;
IER |= 0x0008; /lenable INT4 in IER
IER &= OXFFF7; /ldisable INT4 in IER
/*** Global Interrupts ***/
asm(“ CLRC INTM"); //enable global interrupts
asm(“ SETC INTM"); //disable global interrupts
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Reset, Interrupts and System Initialization

Peripheral Interrupt Expansion (PIE)

Peripheral Interrupt Expansion - PIE

Interrupt Group 1
PIEIFR1 PIEIER1
INT1.x interrupt group INTL.1 e

A—[1}— -
INT2.x interrupt group H
|NT1.2_.@_/_

— PIE module for 96 Interrupts

96

INT3.x interrupt group

. INT1
INT4.x interrupt group . .
INT5.x interrupt group INTL8 /°
o —>.—1 —

INT6.x interrupt group
INT7.x interrupt group

I8l

28x Core Interrupt logic

INT8.x interrupt group

INT9.x interrupt group INT1 —INT12

28x
Core

INT10.x interrupt group

12 Interrupts

Peripheral Interrupts 12x 8

INT11.x interrupt group

INT12.x interrupt group

INT13 (TINT1)
INT14 (TINT2)
NMI

F2806x PIE Interrupt Assignment Table

INTX.8 INTX.7 INTx.6 [ INTx.5 INTx.4 INTx.3 INTx.2 INTx.1

INT1 WAKEINT TINTO ADCINT9 XINT2 XINT1 ADCINT2 | ADCINT1

INT2 | EPWM8 | EPWM7 [ EPWM6 [ EPWM5 | EPWM4 | EPWM3 | EPWM2 | EPWM1
_TZINT | _TZINT | _TzINT | _TzINT | _TZINT | _TZINT | _TZINT | _TzZINT

INT3 EPWM8 EPWM7 EPWM6 | EPWM5 EPWM4 EPWM3 EPWM2 EPWM1

CINT CINT CINT CINT CINT INT CINT CINT
INT4 | HRCAP2 | HRCAPI ECAP3 | ECAP2 | ECAPL
CINT CINT CINT INT INT
P HRCAP4 | HRCAP3 EQEP2 | EQEPL
CINT CINT CINT CINT
SPITX | SPIRX | SPITX | SPIRX
INT6 MXINTA | MRINTA | 7R INTB INTA INTA
INT7 DINTCHS | DINTCH5 | DINTCH4 | DINTCH3 | DINTCH2 | DINTCH1
INT8 I2CINT2A | 12CINT1A
INTS ECANL | ECANO | SCITX | SCIRX | SCITX | SCIRX
CINTA | INTA INTB INTB INTA INTA

INT10 | ADCINT8 | ADCINT7 | ADCINT6 | ADCINTS | ADCINT4 [ ADCINT3 | ADCINT2 | ADCINT1

INT11 CLAL CLAL CLAL CLAL CLAL CLAL CLAL CLAL
CINT8 CINT7 _INT6 INT5 CINT4 CINT3 CINT2 CINTL
INT12 LUF LVF XINT3
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PIE Registers

PIEIFRX register  (x =1to 12)
15-8 7 6 5 4 3 2 1 0

reserved INTX.8[ INTX.7| INTX.6 | INTX.5[ INTX.4[ INTX.3[ INTx.2] INTX.1

PIEIERx register (x=1to 12)
15-8 7 6 5 4 3 2 1 0

reserved | INTX.8| |NTX.7| INTX.G‘ |NTX.5| |NTX.4| |NTX.3| INTX.2| INTX.1|

PIE Interrupt Acknowledge Register (PIEACK)
15-12 1 10 9 8 7 6 5

reserved PIEACKXx

4 3 2 1 0

PIECTRL register 15-1 0
PIEVECT ENPIE

#include “F2806x_Device.h”
PieCtrIRegs.PIEIFR1.bit.INTx4 = 1; //manually set IFR for XINT1 in PIE group 1
PieCtrIRegs.PIEIER3.bit.INTx2 = 1; //enable EPWM2_INT in PIE group 3
PieCtrIRegs.PIEACK.all = 0x0004; //acknowledge the PIE group 3
PieCtrIRegs.PIECTRL.bit.ENPIE = 1; //enable the PIE

PIE Block Initialization

Main.c Memory Map
// CPU Initialization @
InitPieCtri();
= PIE RAM
R Vectors
) ) - 256w
PieVect.c PieCtrl.c | (ENPIE = 1)
PIE_VECT_TABLE // Initialize PIE_RAM @
// Base Vectors @ S
9 » memcpy(see);
5 S Boot ROM
// Core INT1 re-ma o
= P // Enable PIE Block Reset Vector
- PieCtrlRegs.
// Core INT12 re-map PIECTRL.DIT. ssaadusssssssasasssasssnsnsnsssnsasasannnst
= TS
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PIE Initialization Code Flow - Summary

RESET Reset Vector Boot option determines
<O0x3F FFCO0> <0x3F F75C> = Boot Code | code execution entry point

CodeStartBranch.asm

1 1 .sect “codestart”
MOSARAM Entry Point OR Flash Entry Point
<0x00 0000> = LB _c_int00 <O0x3F 7FF6> = LB _c_int00

I I
¥

_C_int00: rts2800_fpu32.lib

CALL mainQ) v
PIE Vector Table

Main.c { Initialization() » 256 Word RAM
- 0x00 0D0OO — ODFF

main() Load PIE Vectors T
{ initialization(); Enag:e ;?EIEQE H Defaultlsr.c

: nable - . >

: Enable Core IER interrupt void name(void)
¥ Enable INTM { )

* :
T

Oscillator / PLL Clock Module

(lab file: SysCitrl.c)
WDCLKSRCSEL
Internal | OSC1CLK .
OSC 1 0*] WDCLK | Watchdog
(10 MHz) 1 Module
OSCCLKSRCSEL
OSCCLKSRC2 H
internal | osczcLk lh —»Bﬁ _ OSCCLK DIVSEL
PLL H
(10 MHz) o 1 (PLL bypass) =< CLKIN
g —11/n C28x
VCOCLK Core
PLL g
XCLKINOFF o i SYSCLKOUT
1 1 —
XCLKIN DIV
DM- TMR2CLKSRCSEL LOSPCP
—{10 LSPCLK
&, 11 | CPUTMR2CLK SCI, SPI
; 8%* All other peripherals
SYSCLKOUT — CPU clocked by SYSCLKOUT
X2 Timer 2
* = default
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Reset, Interrupts and System Initialization

F2806x PLL and LOSPCP

(lab file: SysCtrl.c)

DIV

00000
00001
00010
00011
00100
00101
00110
00111
01000
01001
01010
01011
01100
01101
01110
01111
10000
Ixxx1

0SCCLK SysCt:rIRegs.PLLSTS.blt.DIVSEL
(PLL bypass)
pas CLKIN | C28x SYSCLKOUT
g —{1/n Core v
VEOCLK e LSPCLK
—{ PLL v .
SysCtriRegs.PLLCR.bit.DIV SysCtrIRegs.LOSPCP.bit.LSPCLK
CLKIN
OSCCLK /n * (PLL bypass) LSPCLK | Peripheral Clk Freq
OSCCLK x1/n S I 000 | SYSCLKOUT/1
OSCCLK x 2/n 001 | SYSCLKOUT/2
OSCCLK x3/n 0x 4% 010 | SYSCLKOUT/4*
OSCCLK x 4/n 10 2 011 | SYSCLKOUT/6
OSCCLK x5/n 11 il 100 | SYSCLKOUT/8
OSCCLK x 6/n ~ default 101 | SYSCLKOUT/10
OSCCLK x 7/n Note: /1 mode can 110 | SYSCLKOUT/12
OSCCLK x 8/n o
oscclkx 8/ only be used when 111 | SYSCLKOUT/14
LKx9/n PLL is bypassed LSBs in reg. — others reserved

OSCCLK x 10/n
OSCCLK x 11/n
OSCCLK x 12/n
OSCCLK x 13/n
OSCCLK x 14 /n
OSCCLK x 15/n
OSCCLK x 16/n

reserved

Input Clock Fail Detect Circuitry

PLL will issue a “limp mode” clock (1-4 MHz) if input
clock is removed after PLL has locked.

An internal device reset will also be issued (XRSn
pin not driven).

Watchdog Timer Module

Watchdog Timer

¢ Resets the C28x if the CPU crashes
¢ Watchdog counter runs independent of CPU

¢ If counter overflows, a reset or interrupt is
triggered (user selectable)

¢ CPU must write correct data key sequence
to reset the counter before overflow

¢ Watchdog must be serviced or disabled
within 131,072 WDCLK cycles after reset

& This translates to 13.11 ms with a 10 MHz
WDCLK
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Watchdog Timer Module

(lab file: Watchdog.c)

WDPS WDOVERRIDE
Watchdog 7
WDCLK /512
- Prescaler WDDIS
8-bit Watchdog
Counter
CLR
System WDRST
Output—>
Reset Pulse >
WDINT
55 + AA
Detector| good Key
T Bad WDCHK Key
Watchdog
Reset Key
Register

GPIO

F2806x GPIO Grouping Overview

(lab file: Gpio.c)

GPIO Pcz(rBtAMuxl) nput o
<« Register (GPAMUX1) |¢—p
[GPIO 0 to 15]  GPIO PortA e 3
Direction Register Qual e}
(GPADIR) o[>
GPIO Port A Mux2 [GPIO 0 to 31] | S
<« Register (GPAMUX2) |le—b >
GPIO 16 to 31]
GPIO Port B Mux1 ]
S |«—»| Register (GPBMUX1) |«—» _|Input] g
3 GPIO 32 to 47]  GPIO Port B Qual 3
S Direction Register (e}
o (GPBDIR) o[«
w GPIO Port B Mux2 [GPIO 32 to 63] > S
S |e—>» Register (GPBMUX2) |e—b =
[GPIO 48 to 63]
2
ANALOG Port (e >
ANALOG 1/0 Mux1 Direction Register Py
«——>» Register (AIOMUX1) |e—> O [—>
[AIO 0 to 15] (el o)
[AIO 0 to 15] -
o
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F2806x GPIO Pin Block Diagram

(lab file: Gpio.c)

I/O DIR Bit Per|phera| Perlpheral Perl%heral
GPXSET 0=

Input
GPXCLEAR 1= Output
GPXTOGGLE
GPXDIR
GPXDAT |

Out l\' .......................................... GPxMUX1
/O DAT | oo‘\T 11 GPXMUX2

Bit (R/IW) | |n MUX Control Bits *
00 = GPIO
01 = Peripheral 1
10 = Peripheral 2

11 = Peripheral 3

Input
Qualification
(€123 =101 ) F—— (GPIO 0-44) GPXQSEL1
GPxQSEL2
Internal Pull-Up GPxCTRL
0 = enable (default GPIO 12-58)
1 = disable (default GPIO 0-11)
Pin

* See device datasheet for pin function selection matrices

F2806x GPIO Input Qualification
LT

Input to GPIO and
pin O ___ peripheral
Qualification modules
1

SYSCLKOUT

¢ Qualification available on ports A & B only

¢ Individually selectable per pin R
¢ no qualification (peripherals only)
¢ sync to SYSCLKOUT only l ‘ l

¢ qualify 3 samples
¢ qualify 6 samples <
S

# AlO pins are fixed a
‘sync to SYSCLKOUT’ T T T

T = qual period

C2000 MCU 1-Day Workshop
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Reset, Interrupts and System Initialization

Lab 2: System Initialization

¢ LAB2 files have been provided

¢ LAB2 consists of two parts:
Partl
& Test behavior of watchdog when disabled and enabled
Part 2

# Initialize peripheral interrupt expansion (PIE) vectors and
use watchdog to generate an interrupt

+ Modify, build, and test code using Code
Composer Studio

40
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Lab 2: System Initialization

Lab 2: System Initialization
» Objective

The objective of this lab is to perform the processor system initialization. Additionally, the
peripheral interrupt expansion (PIE) vectors will be initialized and tested. The system
initialization for this lab will consist of the following:

e  Setup the clock module — PLL, LOSPCP = /4, low-power modes to default values, enable all
module clocks

e Disable the watchdog — clear WD flag, disable watchdog, WD prescale = 1

e Setup the watchdog and system control registers — DO NOT clear WD OVERRIDE bit,
configure WD to generate a CPU reset

e Setup the shared 1/0 pins — set all GPIO pins to GPIO function (e.g. a "00" setting for GPIO
function, and a “01”, “10”, or *“11” setting for peripheral function)

The first part of the lab exercise will setup the system initialization and test the watchdog
operation by having the watchdog cause a reset. In the second part of the lab exercise the PIE
vectors will be tested by using the watchdog to generate an interrupt. This lab will make use of
the F2806x C-code header files to simplify the programming of the device, as well as take care of
the register definitions and addresses. Please review these files, and make use of them in the
future, as needed.

> Procedure

Open the Project

1. A project named Lab2 has been created for this lab. Open the project by clicking on
Project - Import Existing CCS/CCE Eclipse Project. The “Import”
window will open then click Browse... next to the “Select search-directory” box.
Navigate to: C:\C28x\Labs\Lab2\Project and click OK. Then click Finish to
import the project.

2. Inthe Project Explorer window, click the plus sign (+) to the left of Lab2 to view
the project files. All Build Options have been configured for this lab. The files used in

this lab are:

CodeStartBranch.asm Lab.h
Defaultlsr_2.c Lab 2 3.cmd
DelayUs.asm Main_2.c
F2806x_Defaultlsr.h PieCtrl.c
F2806x_GlobalVariableDefs.c PieVect.c
F2806x_Headers_nonBI0OS.cmd SysCtrl.c
Gpio.c Watchdog.c
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Modified Memory Configuration

3.

Open and inspect the linker command file Lab_2 3.cmd. Notice that the user defined
section ““codestart” is being linked to a memory block named BEGIN_MO. The
codestart section contains code that branches to the code entry point of the project. The
bootloader must branch to the codestart section at the end of the boot process. Recall that
the emulation boot mode "M0 SARAM" branches to address 0x000000 upon bootloader
completion.

The linker command file (Lab_2_3.cmd) has a new memory block named BEG IN_MO:
origin = 0x000000, length = 0x0002, in program memory. Additionally, the existing
memory block MOSARAM in data memory has been modified to avoid overlaps with this
new memory block.

In the linker command file, notice that RESET in the MEMORY section has been defined
using the “(R)” qualifier. This qualifier indicates read-only memory, and is optional. It
will cause the linker to flag a warning if any uninitialized sections are linked to this
memory. The (R) qualifier can be used with all non-volatile memories (e.g., flash, ROM,
OTP), as you will see in a later lab exercise.

System Initialization

5.

Open and inspect SysCtrl .c. Notice that the PLL and module clocks have been
enabled.

Open and inspect Watchdog - c. Notice that the watchdog control register (WDCR) is
configured to disable the watchdog, and the system control and status register (SCSR) is
configured to generate a reset.

Open and inspect Gpio.c. Notice that the shared 1/0 pins have been set to the GP1O
function, except for GP100 which will be used in the next lab exercise. Close the
inspected files.

Build and Load

8.

10.

Click the “Bui 1d” button and watch the tools run in the Consol e window. Check for
errors in the Problems window.

Click the “Debug” button (green bug). The “CCS Debug Perspective” view should
open, the program will load automatically, and you should now be at the start of
main().

After CCS loaded the program in the previous step, it set the program counter (PC) to
pointto _c_int0O0. Itthen ran through the C-environment initialization routine in the
rts2800_fpu32.11b and stopped at the start of main(). CCS did not do a device
reset, and as a result the bootloader was bypassed.

In the remaining parts of this lab exercise, the device will be undergoing a reset due to the
watchdog timer. Therefore, we must configure the device by loading values into
EMU_KEY and EMU BMODE so the bootloader will jump to “M0 SARAM” at address
0x000000. Set the bootloader mode using the menu bar by clicking:

Scripts > EMU Boot Mode Select -> EMU_BOOT_SARAM

42
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If the device is power cycled between lab exercises, or within a lab exercise, be sure to
re-configure the boot mode to EMU_BOOT_SARAM.

Run the Code — Watchdog Reset

11.

12.

13.

14.

15.

16.

17.

Place the cursor in the “main loop” section (on the asm(*“ NOP’”) ; instruction line)
and right click the mouse key and select Run To Line. This is the same as setting a
breakpoint on the selected line, running to that breakpoint, and then removing the
breakpoint.

Place the cursor on the first line of code in main() and set a breakpoint by double
clicking in the line number field to the left of the code line. Notice that line is
highlighted with a blue dot indicating that the breakpoint has been set. The breakpoint is
set to prove that the watchdog is disabled. If the watchdog causes a reset, code execution
will stop at this breakpoint.

Run your code for a few seconds by using the “Resume” button on the toolbar, or by
using Run > Resume on the menu bar (or F8 key). After a few seconds halt your
code by using the “Suspend” button on the toolbar, or by using Run > Suspend on
the menu bar (or alt-F8 key). Where did your code stop? Are the results as expected? If
things went as expected, your code should be in the “main loop”.

Switch to the “CCS Edit Perspective” view by clicking the CCS Edit icon in the upper
right-hand corner. Modify the InitWatchdog() function to enable the watchdog
(WDCR). InWatchdog.c change the WDCR register value to 0XO0A8. This will
enable the watchdog to function and cause a reset. Save the file.

Click the “Bui 1d” button. Select Yes to “Reload the program automatically”. Switch
back to the “CCS Debug Perspective” view by clicking the CCS Debug icon in the
upper right-hand corner.

Like before, place the cursor in the “main loop” section (on the asm(* NOP’*);
instruction line) and right click the mouse key and select Run To Line.

Run your code. Where did your code stop? Are the results as expected? If things went
as expected, your code should have stopped at the breakpoint. What happened is as
follows. While the code was running, the watchdog timed out and reset the processor.
The reset vector was then fetched and the ROM bootloader began execution. Since the
device is in emulation boot mode (i.e. the emulator is connected) the bootloader read the
EMU_KEY and EMU_BMODE values from the PIE RAM. These values were
previously set for boot to MO SARAM bootmode by CCS. Since these values did not
change and are not affected by reset, the bootloader transferred execution to the
beginning of our code at address 0x000000 in the MOSARAM, and execution continued
until the breakpoint was hit in main().

Setup PIE Vector for Watchdog Interrupt

The first part of this lab exercise used the watchdog to generate a CPU reset. This was tested
using a breakpoint set at the beginning of main(). Next, we are going to use the watchdog
to generate an interrupt. This part will demonstrate the interrupt concepts learned in this
module.
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18.

19.

20.

21.

22.

23.

24.

Switch to the “CCS Edit Perspective” view by clicking the CCS Edit icon in the upper
right-hand corner. Notice that the following files are included in the project:
Defaultlsr_2.c

PieCtrl.c

PieVect.c

In Main_2.c, uncomment the code used to call the InitPieCtrl() function. There
are no passed parameters or return values, so the call code is simply:

InitPieCtri();

Using the “PIE Interrupt Assignment Table” shown in the slides find the location for the
watchdog interrupt, “WAKEINT”. This is used in the next step.

PIE group #: # within group:

In main() notice the code used to enable global interrupts (INTM bit), and in
InitWatchdog() the code used to enable the “WAKEINT” interrupt in the PIE
(using the PieCtrIRegs structure) and to enable core INT1 (IER register).

Modify the system control and status register (SCSR) to cause the watchdog to generate
a WAKEINT rather than a reset. In Watchdog . c change the SCSR register value to
0x0002. Save the modified files.

Open and inspect Defaultlsr_2.c. This file contains interrupt service routines. The
ISR for WAKEINT has been trapped by an emulation breakpoint contained in an inline
assembly statement using “ESTOPO”. This gives the same results as placing a breakpoint
in the ISR. We will run the lab exercise as before, except this time the watchdog will
generate an interrupt. If the registers have been configured properly, the code will be
trapped in the ISR.

Open and inspect PieCtrl _c. This file is used to initialize the PIE RAM and enable
the PIE. The interrupt vector table located in PieVect. c is copied to the PIE RAM to
setup the vectors for the interrupts. Close the modified and inspected files.

Build and Load

25.

Click the “Bui 1d” button and select Yes to “Reload the program automatically”.
Switch to the “CCS Debug Perspective” view by clicking the CCS Debug icon in the
upper right-hand corner.

Run the Code — Watchdog Interrupt

26.

27.

Place the cursor in the “main Boop” section, right click the mouse key and select Run
To Line.

Run your code. Where did your code stop? Are the results as expected? If things went
as expected, your code should stop at the “ESTOPO” instruction in the WAKEINT ISR.
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Terminate Debug Session and Close Project

28. Terminate the active debug session using the Terminate button. This will close the
debugger and return CCS to the “CCS Edit Perspective” view.

29. Next, close the project by right-clicking on Lab2 in the Project Explorer window
and select Close Project.

End of Exercise

Note: By default, the watchdog timer is enabled out of reset. Code in the file
CodeStartBranch.asm has been configured to disable the watchdog. This can be
important for large C code projects (ask your instructor if this has not already been
explained). During this lab exercise, the watchdog was actually re-enabled (or disabled
again) in the file Watchdog. c.
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Control Peripherals

ADC Module

ADC Module Block Diagram
ADCINAO —>
ADCINAL=IMux | ISH RESULTO
: A A RESULTL
ADCINA7 — X 12-bit A/D
g A X RESULT?2
ADCINBO —» onverter
ADCINB1 = MuXx S/H SOCx
H B B
ADCINB7 —
T CHSEL ADC. | Eocx ADC | ADCINT1-9
ADC full-scale Generation Interrupt >
|n%utt r%n?g’\e/ is Logic Logic
0 3.
SOCx Signal ADCINT1
ADCINT?2
SOCO |[TRIGSEL |CHSEL |ACQPS |
SOC1 |TRIGSEL |CHSEL |ACQPS | ©
SOC2 [TRIGSEL |CHSEL |[ACQPS | & Software
SOC3 |TRIGSEL |CHSEL [ACQPS |&= CPU Timer (0,1,2)
B B B 5 < EPWMxSOCA (x =1 to 8)
: : : |0l EPWMxSOCB (x = 1 to 8)
SOC15 [TRIGSEL [CHSEL JACQPS | External Pin
SOCx Configuration Registers (GPIO/XINT2_ADCSOC)

Example — ADC Triggering aot2

| Sample A2 B3 2 A7 when ePWM1 SOCB is generated and then generate ADCINT1:

SOCB (ETPWM1)

SOCO [ Channel Sample
A2 7 cycles
SOCL1 | Channel Sample
B3 10 cycles
SOC2 | Channel Sample
A7 8 cycles

Result0 no interrupt
Resultl no interrupt
Result2 ADCINT1

As above, but also sample A0 = BO => A5 continuously and generate ADCINT2:

SOCB (ETPWM1)

Software Trigger

Result0 no interrupt

Resultl no interrupt

Result2 ADCINT1

ADCINT2

Result3 no interrupt

Result4 no interrupt

SOCO | Channel Sample
A2 7 cycles

SOCL1 [ Channel Sample
B3 10 cycles

SOC2 | Channel Sample
A7 8 cycles

SOC3 [ Channel Sample
7 A0 10 cycles
SOC4 | Channel Sample
BO 15 cycles

SOCS | Channel Sample
A5 12 cycles

Results ADCINT2

46
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Example — ADC Triggering @of2

| Sample all channels continuously and provide Ping-Pong interrupts to CPU/system: |

Software Trigger soco [Channel Sl Resulio .
ADCINT2 j "l AO0:BO 7 cycles Resultl no interrupt
SOC2 | Channel Sample Result2 )
Al:B1 7cycles Result3 no interrupt
SOC4 || Channel Sample Result4 L
A2:B2 7 cycles Resulis no interrupt
SOC6 [ Channel Sample Result6
A3:B3 7 cycles Result? > ADCINT1
SOC8 | Channel Sample Result8 )
A4:B4 7 cycles Result9 » No interrupt
SOC10 [ Channel Sample Result10 )
A5:B5 7 cycles Resultil no interrupt
SOC12 | Channel Sample Result12 )
A6:B6 7 cycles Resulii3 no interrupt
SOC14| Channel Sample Result14 .
AT:BT 7 cycles Resultis |~ ADCINT2
A0 @
LBOe®
Al @
L Ble
A2 e v :
—AI02 | |10-bit w} COMP1OUT
—] DAC
B2 e “ AlO10 I
A3 @
L B3e
[hse 4 - ADC
—{ AI04 | | 10-bit W COMP20UT
—] DAC
B4 e \ AlO12 I
AS @
_B5®
A6 @ 7 :
— AlO6 | | 10-bit W COMP30UT
—] DAC
_B6e N AlO14 1
A7 @
lLLB7 @
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ADC Control Registers gile: Adc.c)

¢ ADCTRL1 (ADC Control Register 1)
& module reset, ADC enable
¢ busy/busy channel
¢ reference select
¢ Interrupt generation control
¢ ADCSOCXCTL  (SOCO0to SOC15 Control Registers)
& trigger source
¢ channel
& acquisition sampling window
¢ ADCINTSOCSELx (Interrupt SOC Selection 1 and 2 Registers)
¢ selects ADCINT1 / ADCINT2 trigger for SOCx
¢ ADCSAMPLEMODE (Sampling Mode Register)
¢ sequential sampling / simultaneous sampling
¢ INTSELxNy (Interrupt x and y Selection Registers)
¢ EOCO - EOC15 source select for ADCINT1-9
¢ ADCRESULTx  (ADC Result 0to 15 Registers)

Note: refer to the reference guide for a complete listing of registers

Pulse Width Modulation
What is Pulse Width Modulation?

¢ PWM is a scheme to represent a
signal as a sequence of pulses
ofixed carrier frequency
ofixed pulse amplitude

epulse width proportional to
instantaneous signal amplitude

¢ PWM energy ~ original signal energy

IIIIIIHt

Original Signal PWM representation
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Why use PWM with Power
Switching Devices?
¢ Desired output currents or voltages are known

¢ Power switching devices are transistors
« Difficult to control in proportional region
¢ Easy to control in saturated region

¢ PWM is a digital signal = easy for MCU to output

DC Supply DC Supply
P fmaar
' _ PWM
D_esw:a:i PWM approx.
signal to of desired
/\/\/ system "_”J-I.Hﬂ_ﬂﬂ signal
Unknown Gate Signal Gate Signal Known with PWM

ePWM

ePWM Module Signals and Connections

—-’\
ePWMx-1

EPWMxSYNCI EPWMXTZINT
GPIO TZ1-TZ3
MUX EPWMXINT PIE
EQEP1ERR — TZ4 EPWMXA
PeEnt GPIO
syscrry CLOCKFAIL -T25 | € PWMx EPWME MUX
cpyy EMUSTOP - 726
EPWMxSOCA
CcComp |_COMPxOUT EPWMxsOCB | ADC
EPWMxSYNCO
v
ePWMx+1
]
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ePWM Block Diagram

Shadowed Shadowed
Clock Compare Compare
Prescaler Register Register
Tin11g_-BBlat15e Compare Action Dead
TBCLK Counter Logic Qualifier j— Band_l
EPWMXSYNCI EPWMxSYNCO N
Period H
................ : Register L r— = EPWMxA
i rip f—>
: (STl Chopper Zone [—
SYSCLKOUT EPWMxB
I_t ] TZy

Digita| led TZ1-TZ3
Compare [¢—— COMPxOUT

ePWM Time-Base Sub-Module

:

[ Shadowed [ Shadowed
»> Clock Compare Compare
= |Prescaler Register Register
E 16-Bit ;
P L rime-sase Ly Sprnare [ fetlen 1 pead
1 1 Counter

EPWMxSYNCI EPWMxSYNCO "
Period |

LLLELLLS Reg|ste|’ - EPWMxA
H PWM Trip
. Shadowed
H Chopper Zone fp—»
SYSCLKOUT EPWMxB
—

Digital |ed T21-T23
Compare [«—— COMPxOUT
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ePWM Time-Base Count Modes

TBCTR

TBPRD

Asymmetrical
Waveform

TBCTR
TBPRD
Asymmetrical
Waveform
Count Down Mode -
TBCTR
TBPRD
Symmetrical
Waveform

Count Up and Down Mode

ePWM Phase Synchronization

Ext. Syncin
(optional)

Phase En _ Syncin
O EPWM1A
—

CTR=zero |
CTRECMPE —0. "0 | EPWMLB |
X = — -

SyncOut i

To eCAP1
Syncin

Phase En  Syncin

$=120 0~ EPWM2A
———p

CTR=zero=—0 \
CTR=CMPB—0 © EPWM2B

X Q) >

SyncOut

Phase En  Syncin

$=240 0= EPWM3A
e

Q
CTR=zero ==0
CTR=CMPB=—0 © EPWM3B
X =0 —
SyncOut
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ePWM Compare Sub-Module

Clock
Prescaler
Tin11g_-BBlat15e Compare jm=—p Action Dead
TBCLK Counter Logic Jeppi Qualifier f——s| Band _|
EPWMXSYNCI EPWMxSYNCO "
Period
Register L - EPWMxA
Shadowed [P U P o
i Chopper Zone f——
SYSCLKOUT EPWMxB
r__j 1 TZy

Digita| led TZ1-TZ3
Compare [¢—— COMPxOUT

ePWM Compare Event Waveforms

TBCTR |o = compare events are fed to the Action Qualifier Sub-Module |

TBPRD

CMPA il Salnlelely Asymmetrical
CMPB boeeeeeeee bl el  JE— Waveform

TBCTR

TBPRD

CMPA
CMPB

TBCTR

TBPRD

CMPA
CMPB

Symmetrical
Waveform

Count Up and Down Mode
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ePWM Action Qualifier Sub-Module

Shadowed J Shadowed J

. Clock Compare Compare
Prescaler Register Register
Tirig:BBgse Compare Action [m=p| Dead
TBCK | sounter Logic Qualifier j——mpp{ Band _|
EPWMXxSYNCI EPWMXxSYNCO N
Period H
................ : Reqister EPWMxA
: Shidowed | _PwM Ui o
i Chopper Zone f——
SYSCLKOUT EPWMxB
I_t TZy

Digita| led TZ1-TZ3
Compare [¢—— COMPxOUT

ePWM Action Qualifier Actions

for EPWMA and EPWMB

SW Time-Base Counter equals: EPWM
Force Ou?put
Zero CMPA CMPB TBPRD Actions
S)\(N )Z( C)? CXB )Fz Do Nothing
SlN i Cf‘ C¢B 5 Clear Low
SWELTZEETCA] | [B] [ R T setvin
SW Z CA CB P
T T T T T Toggle
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ePWM Count Up Asymmetric Waveform

with Independent Modulation on EPWMA /B

TBCTR

TBPRD

llﬁ l llﬁ l ll

EPWMAl l
llﬁ B lll B ll

crwee [ I

ePWM Count Up Asymmetric Waveform

with Independent Modulation on EPWMA

TBCTR

TBPRD

EPWMA |

Ex
|

EPWMB |
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ePWM Count Up-Down Symmetric
Waveform

with Independent Modulation on EPWMA /B

TBCTR

TBPRD

EPWMA |

EPWMB |

ePWM Count Up-Down Symmetric
Waveform

with Independent Modulation on EPWMA

TBCTR

TBPRD

EPWMB I

C2000 MCU 1-Day Workshop

55



Control Peripherals

ePWM Dead-Band Sub-Module

Prescaler

Shadowed J

Clock Compare
Register

Shadowed J

Compare
Register

16-Bit

o

Compare

Time-Base
Counter

111

EPWMxSYNCI

TBCLK

EPWMxSYNCO

Logic

Action

Qualifier

Dead
Band

Period |

SYSCLKOUT

Register

Shadowed

EPWMxA

L PWM

Chopper Zone [—

Trip —>

EPWMxB
I_t { TZy

Digita| led TZ1-TZ3
Compare [¢—— COMPxOUT

Motivation for Dead-Band

gate signals are

complementary PWM

¢ Transistor gates turn on faster than they shut off
¢ Short circuit if both gates are on at same time!

supply rail

to power
switching
device
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ePWM PWM Chopper Sub-Module

Shadowed J Shadowed J

Clock Compare Compare
Prescaler Register Register
Ti;g:ggse Compare Action Dead
TBCLK Counter Logic Qualifier j———| Band _|
EPWMXxSYNCI EPWMXxSYNCO N
Period H
................ : Register L S = EPWMxA
i ey Trip ——>
i Sz Chopper jup{ Zone F——>
SYSCLKOUT EPWMxB
I_t 1 TZy

Digita| led TZ1-TZ3
Compare [¢—— COMPxOUT

ePWM Chopper Waveform

EPWMXA |

EPWMxB '_|
CHPFREQ |”II”””””””””"”ﬂ_ﬂ”_||||||||||”||”””||”“”|

EPWMxA

|
]

EPWMxB |||| i

_: Programmable

OSHT (%%?Tvv\\//igm)
EPWMXA | ||||||i||””| Sustaining |

With One-Shot Pulse on EPWMxA and/or EPWMxB
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ePWM Digital Compare and Trip-Zone
Sub-Modules

Shadowed Shadowed
Clock Compare Compare
Prescaler Register Register
Tin11g_-BBlat15e Compare Action Dead
TBCLK Counter Logic Qualifier j———| Band _|
EPWMXSYNCI EPWMxSYNCO N
Period H
Register L r— = EPWMxA
rip
: Sz Chopper Zone
SYSCLKOUT EPWMxB

TZy
TZ1-TZ3

Digital
Comparej == COMPxOUT

Digital Compare Sub-Module Signals

Time-Base Sub-Module

—-| Generate PWM Sync [

Event-Trigger Sub-Module

Generate SOCA |

Trip-Zone Sub-Module

Trip PWMA Output

> Generate Trip Interrupt

Time-Base Sub-Module

—-| Generate PWM Sync [

Event-Trigger Sub-Module

Generate SOCB |

Trip-Zone Sub-Module

Trip PWMB Output

DCAEVT1
_\ DCAH Digital Trip
TZ1 ) Event Al
 E— d — Compare [<---- ]
i : blanking
TZ2 : e ;
—_— : »| Digital Trip [€-----
DCAL Event A2 i
173 — Compare l
— g : DCAEVT2
COMP10OUT : i
Mt : :
H DCBEVT1
o | DCBH Digital Trip
compzout | | Event B1
—_— d — Compare [«---- |
i : blanking
COMP3OUT, i Digital Trip |¢-----
DCBL Event B2
h— Compare
. i DCBEVT2
DCTRIPSEL TZDCSEL

Generate Trip Interrupt

DCACTL / DCBCTL -----

58

C2000 MCU 1-Day Workshop



Control Peripherals

¢ Supports:

Over

Trip-Zone Features

¢ Trip-Zone has a fast, clock independent logic path to high-impedance
the EPWMXA/B output pins

¢ Interrupt latency may not protect hardware when responding to over
current conditions or short-circuits through ISR software

current c

onditions

#1) one-shot trip for major short circuits or over

#2) cycle-by-cycle trip for current limiting operation

EPWM1A
———

EPWM1B
—

Current
Sensors CPU
core
COMPxOUT Digital
Complie EPWMxXTZINT
TZ1 Cycle-by-Cycle
122 Mode
TZ3
TZ4 EQEPIERR
eQEP1 ’
syscTRL__TZ5 CLOCKFAIL One-Shot
de
cpu—__T26 EMUSTOP Mo

y
nw-HCUHCO Z=7U

EPWMxA
———
EPWMxB

ePWM Event-Trigger Sub-Module

Clock
Prescaler
16-Bit )
Time-Base L—{ CP0Pae [ Aeton, || o
TBCLK Y Counter t —|
EPWMxSYNCI EPWMxSYNCO "
Period
Register L r— = EPWMxA
rip
; [Shadowed | Chopper Zone fp—»
SYSCLKOUT EPWMxB
Tzy

Digital fe=

TZ1-TZ3

Comparefje—— COMPxOUT
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ePWM Event-Trigger Interrupts and SOC

TBCTR
TBPRD
CMPB
CMPA

1
]
'
-
] '
] ]
] ]
] ]
] ]
] ]
] ]
]
]
]
]
]
]

[NV -
[NV [ PR

[NV IVIP [FRypRyY P S -

@]

—

Pyl

1

o
lI..} -‘)—

CTR=PRD | t | |
CTR=00r PRD 1 RN
CTRU = CMPA . f
CTRD=CMPA | | | | f R f 5
CTRU=CMPB || t )
CTRD = CMPB | P f 5 i Lol f i 5

Hi-Resolution PWM (HRPWM)

PWM Period

&
< >

Regular
Device Clock  AAAMMLAMUUILULUIUUIIUUIIIUIIIIInun - PWM step

(e 8OMHR) TTTTT ————— ] (e 12509

HRPWM divides a clock Calibration Logic tracks the

cycle into smaller steps m _._._._ number of Micro Steps per
i i 11 S M S P S pmr i mnan p
called Micro Steps clock to account for

(Step Size ~= 150 ps) | Calibration Logic | variations caused by
Temp/Volt/Process
I HRPWM

FEEEEETEEEEEEEEETTEET Tl Micro Step (=150 ps)

& Significantly increases the resolution of conventionally derived digital PWM

& Uses 8-bit extensions to Compare registers (CMPxHR), Period register
(TBPRDHR) and Phase register (TBPHSHR) for edge positioning control

¢ Typically used when PWM resolution falls below ~9-10 bits which occurs at
frequencies greater than ~160 kHz (with system clock of 80 MHz)

¢ Not all ePWM outputs support HRPWM feature (see device datasheet)
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ePWM Control Registers ie: epwm.c)

¢ TBCTL (Time-Base Control)

¢ counter mode (up, down, up & down, stop); clock prescale; period shadow
load; phase enable/direction; sync select

¢ CMPCTL (Compare Control)
& compare load mode; operating mode (shadow / immediate)
¢ AQCTLA/B  (Action Qualifier Control Output A/B)
¢ action on up/down CTR = CMPA/B, PRD, 0 (nothing/set/clear/toggle)
¢ DBCTL (Dead-Band Control)
¢ in/out-mode (disable / delay PWMxA/B); polarity select
¢ PCCTL (PWM-Chopper Control)
¢ enable/disable; chopper CLK freq. & duty cycle; 1-shot pulse width
¢ DCTRIPSEL  (Digital Compare Trip Select)
¢ Digital compare A/B high/low input source select
& TZCTL  (Trip-Zone Control)
¢ enable /disable; action (force high / low / high-Z /nothing)
¢ ETSEL (Event-Trigger Selection)
¢ interrupt & SOCA/B enable / disable; interrupt & SOCA/B select

Note: refer to the reference guide for a complete listing of registers

eCAP

Capture Module (eCAP)

@

Timer J |—
YKZ Trigger q
pin
Timestamp
Values

¢ The eCAP module timestamps transitions
on a capture input pin
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eCAP Module Block Diagram - capture Mode
CAP1POL
| Capture1 | __| | __]| Polarity |__
Register Select 1
CAP2POL
|, Capture 2 |__| || Polarity |_|
Register B Select 2 PRESCALE
32-Bit 3 Event
7> Time-Stamp — = — Prescale | crpm
: Counter 2 CAP3POL ECAPx
Capture 3 = Polarity pin
fsasssssmananan = . [ —l
Register Select 3
SYSCLKOUT
CAP4POL
Capture 4 | Polarity
Register Select 4 [

eCAP Module Block Diagram - apwm Mode

[ shadowed

—— U U

- Period
) diat Period Register
Immediate i
mode Register (CAP3)
(CAP1)
32-Bit PWM
> Time-Stamp Compare
H Counter Logic
SYSCLKOUT
. diat Compare
M ede ¢ | Register |compare
(CAP2) Register
[ Shadowed (CAP4)

shadow
mode

ECAP
pin

shadow
mode
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eQEP

What is an Incremental Quadrature
Encoder?
A digital (angular) position sensor

photo sensors spaced 6/4 deg. apart
V slots spaced 0 deg. apart
%@ r light source (LED)
= e i
Ch. A B
ch.B i

0/4
— r—

shaft rotation

Incremental Optical Encoder Quadrature Output from Photo Sensors

How is Position Determined from
Quadrature Signals?

Position resolution is 0/4 degrees

increment decrement

(00) (11)
AB)= 10 5(01) counter counter
|

o 4
llegal
Transitions;
generate
phase error

intefrupt
v

Quadrature Decoder
State Machine

o

C2000 MCU 1-Day Workshop 63



Control Peripherals

eQEP Module Connections

Ch. A

Quadrature
> Capture

EQEPXA/XCLK

32-Bit Unit |_| EQEPXB/XDIR

i Time-Base GEE Quadrature ind

H [~ | Decoder

LY. jratchdog SR —
: EQEPXS Strobe

SYSCLKOUT

from homing sensor

Position/Counter
—> Compare -
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Lab 3: Control Peripherals
» Objective

The objective of this lab is to demonstrate and become familiar with the operation of the on-chip
analog-to-digital converter and ePWM. ePWM1A will be setup to generate a 2 kHz, 25% duty
cycle symmetric PWM waveform. The waveform will then be sampled with the on-chip analog-
to-digital converter and displayed using the graphing feature of Code Composer Studio. The
ADC has been setup to sample a single input channel at a 50 kHz sampling rate and store the
conversion result in a buffer in the MCU memory. This buffer operates in a circular fashion, such
that new conversion data continuously overwrites older results in the buffer.

Two ePWM modules have been configured for this lab exercise:

ePWM1A — PWM Generation

e Used to generate a 2 kHz, 25% duty cycle symmetric PWM waveform
ePWM2 — ADC Conversion Trigger

e Used as a timebase for triggering ADC samples (period match trigger SOCA)

Lab 3: Control Peripherals

ePWM1 dat
TB Counter CPU copies ata
Compare connector ADC result to memory
Action Qualifier wire RESULTO buffer during -
ADC ISR £
o E
ADC- (<
INAO ~ -
. [}
9
. £
b o
o

—

View ADC
buffer PWM
ePWM2 triggering Samples

ADC on period match

using SOCA trigger every

20 ps (50 kHz) ePWM2 Code Composer
Studio

The software in this exercise configures the ePWM modules and the ADC. It is entirely interrupt
driven. The ADC end-of-conversion interrupt will be used to prompt the CPU to copy the results
of the ADC conversion into a results buffer in memory. This buffer pointer will be managed in a
circular fashion, such that new conversion results will continuously overwrite older conversion
results in the buffer. The ADC interrupt service routine (ISR) will also toggle LED LD2 on the
TMS320F28069 controlSTICK as a visual indication that the ISR is running.
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Notes
ePWMI1A is used to generate a 2 kHz PWM waveform

Program performs conversion on ADC channel A0 (ADCINAQO pin)
ADC conversion is set at a 50 kHz sampling rate

ePWM2 is triggering the ADC on period match using SOCA trigger

Data is continuously stored in a circular buffer
Data is displayed using the graphing feature of Code Composer Studio
ADC ISR will also toggle the LED LD?2 as a visual indication that it is running

Procedure

Open the Project

1.

A project named Lab3 has been created for this lab. Open the project by clicking on
Project - Import Existing CCS/CCE Eclipse Project. The “Import”
window will open then click Browse... next to the “Select search-directory” box.
Navigate to: C:\C28x\Labs\Lab3\Project and click OK. Then click Finish to
import the project.

Inthe Project Explorer window, click the plus sign (+) to the left of Lab3 to view
the project files. All Build Options have been configured for this lab. The files used in
this lab are:

Adc.c Gpio.c
CodeStartBranch.asm Lab.h
Defaultlsr_3 4.c Lab 2 3.cmd
DelayUs.asm Main_3.c
EPwm.c PieCtrl.c
F2806x_Defaultlsr.h PieVect.c
F2806x_GlobalVariableDefs.c SysCtrl.c
F2806x_Headers_nonBI0OS.cmd Watchdog.c

Setup GPIO and ePWML1

Note:

DO NOT make any changesto Gpio.c and EPwm.c — ONLY INSPECT

3.

Open and inspect Gpio.c by double clicking on the filename in the project window.
Notice that the shared 1/O pin in GPIOO0 has been set for the ePWM1A function. Next,
open and inspect EPwm.c and see that the ePWM1 has been setup to implement the
PWM waveform as described in the objective for this lab. Notice the values used in the
following registers: TBCTL (set clock prescales to divide-by-1, no software force, sync
and phase disabled), TBPRD, CMPA, CMPCTL (load on 0 or PRD), and AQCTLA (set
on up count and clear on down count for output A). Software force, deadband, PWM
chopper and trip action has been disabled. (Note that the last steps enable the timer count
mode and enable the clock to the ePWM module). See the global variable names and
values that have been set using #define in the beginning of the Lab . h file. Notice that
ePWM2 has been initialized earlier in the code for the ADC. Close the inspected files.
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Build and Load

4.

Click the “Bui 1d” button and watch the tools run in the Console window. Check for
errors in the Problems window.

Click the “Debug” button (green bug). The “CCS Debug Perspective” view should
open, the program load automatically, and you should now be at the start of Main(). If
the device has been power cycled since the last lab exercise, be sure to configure the boot
mode to EMU_BOOT_SARAM using the Scripts menu.

Run the Code — PWM Waveform

6.

Open a memory browser window to view some of the contents of the ADC results buffer.
To open a memory browser window click: View - Memory Browser on the menu
bar. The address label for the ADC results buffer is AdcBuf (type &AdcBuf) in the
“Data” memory page. Select Go to view the contents of the ADC result buffer.

Note:

Exercise care when connecting any wires, as the power to the controlSTICK is on, and
we do not want to damage the controlSTICK! Details of pin assignments can be found
on the last page of this lab exercise.

10.

Using a connector wire provided, connect the PWM1A (pin # 17) to ADCINAO (pin # 3)
on the controlSTICK.

Run your code for a few seconds by using the Resume button on the toolbar, or using
Run -> Resume on the menu bar. After a few seconds halt your code by using the
Suspend button on the toolbar, or by using Run - Suspend on the menu bar. Verify
that the ADC result buffer contains the updated values.

Open and setup a graph to plot a 50-point window of the ADC results buffer.
Click: Tools - Graph - Single Time and set the following values:

Acquisition Buffer Size 50

DSP Data Type

16-bit unsigned integer

Sampling Rate (Hz) 50000
Start Address AdcBuf
Display Data Size 50
Time Display Unit us

Select OK to save the graph options.

The graphical display should show the generated 2 kHz, 25% duty cycle symmetric
PWM waveform. The period of a 2 kHz signal is 500 ps. You can confirm this by
measuring the period of the waveform using the “measurement marker mode” graph
feature. In the graph window toolbar, left-click on the ruler icon with the red arrow.
Note when you hover your mouse over the icon, it will show “Toggle Measurement
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Marker Mode”. Move the mouse to the first measurement position and left-click.
Again, left-click on the Toggle Measurement Marker Mode icon. Move the
mouse to the second measurement position and left-click. The graph will automatically
calculate the difference between the two values taken over a complete waveform period.
When done, clear the measurement points by right-clicking on the graph and select
Remove All Measurement Marks (or Ctrl+Alt+M).

Frequency Domain Graphing Feature of Code Composer Studio

11. Code Composer Studio also has the ability to make frequency domain plots. It does this
by using the PC to perform a Fast Fourier Transform (FFT) of the data. Let's make a
frequency domain plot of the contents in the ADC results buffer (i.e. the PWM
waveform).

Click: Tools > Graph -> FFT Magnitude and set the following values:

Acquisition Buffer Size 50

DSP Data Type 16-bit unsigned integer
Sampling Rate (Hz) 50000

Start Address AdcBuf

Data Plot Style Bar

FFT Order 10

Select OK to save the graph options.

12. On the plot window, hold the mouse left-click key and move the marker line to observe
the frequencies of the different magnitude peaks. Do the peaks occur at the expected
frequencies?

Using Real-time Emulation

Real-time emulation is a special emulation feature that allows the windows within Code
Composer Studio to be updated at up to a 10 Hz rate while the MCU is running. This not
only allows graphs and watch windows to update, but also allows the user to change values in
watch or memory windows, and have those changes affect the MCU behavior. This is very
useful when tuning control law parameters on-the-fly, for example.

13. The memory and single time graph windows displaying AdcBuf should still be open. The
connector wire between PWMZ1A (pin # 17) and ADCINAO (pin # 3) should still be
connected. In real-time mode, we will have our window continuously refresh at the
default rate. To view the refresh rate click:

Window -> Preferences..
and in the section on the left select the “Code Composer Studio” category. Click the plus

sign (+) to the left of “Code Composer Studio” and select “Debug”. In the section on the
right notice the default setting:
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e “Continuous refresh interval (milliseconds)” = 500
Click OK.

Note: Decreasing the “Continuous refresh interval” causes all enabled continuous refresh
windows to refresh at a faster rate. This can be problematic when a large number of
windows are enabled, as bandwidth over the emulation link is limited. Updating too
many windows can cause the refresh frequency to bog down. In this case you can just
selectively enable continuous refresh for the individual windows of interest.

14. Next we need to enable the graph window for continuous refresh. Select the “Single
Time” graph. In the graph window toolbar, left-click on the yellow icon with the arrows
rotating in a circle over a pause sign. Note when you hover your mouse over the icon, it
will show “Enable Continuous Refresh”. This will allow the graph to
continuously refresh in real-time while the program is running.

15. Enable the memory window for continuous refresh using the same procedure as the
previous step.

16. Run the code and watch the windows update in real-time mode. Click:
Scripts »> Realtime Emulation Control - Run_Realtime with_Reset

17. Carefully remove and replace the connector wire from ADCINAOQ (pin # 3). Are the
values updating as expected?

18. Fully halt the CPU in real-time mode. Click:
Scripts - Realtime Emulation Control -> Full_Halt

Terminate Debug Session and Close Project

19. Terminate the active debug session using the Terminate button. This will close the
debugger and return CCS to the “CCS Edit Perspective” view.

20. Next, close the project by right-clicking on Lab3 in the Project Explorer window
and select Close Project.

Optional Exercise

You might want to experiment with this code by changing some of the values or just modify the
code. Try generating another waveform of a different frequency and duty cycle. Also, try to
generate complementary pair PWM outputs. Next, try to generate additional simultaneous
waveforms by using other ePWM modules. Hint: don’t forget to setup the proper shared /O pins,
etc. (This optional exercise requires some further working knowledge of the ePWM.
Additionally, it may require more time than is allocated for this lab. Therefore, you may want to
try this after the class).

End of Exercise
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Lab Reference: F28069 controlSTICK Header Pin Diagram

1 2 3 4
ADC-A6 ADC-A2 ADC-A0 3V3
COMP3 (+VE) | COMP1 (+VE)
5 6 7 8
ADC-A4 ADC-B1 EPWM-4B TZ1
COMP2 (+VE) GP10-07 GPIO-12
9 10 11 12
SCL-A ADC-B6 EPWM-4A ADC-Al
GPI10O-33 COMP3 (-VE) GP10-06
13 14 15 16
SDA-A ADC-B0 EPWM-3B 5V0
GP10-32 GP10-05 (Disabled by
Default)
17 18 19 20
EPWM-1A ADC-B4 EPWM-3A SPISOMI-A
GPI10-00 COMP2 (-VE) GP10-04 GPIO-17
21 22 23 24
EPWM-1B ADC-A5 EPWM-2B SPISIMO-A
GPI10-01 GPI10-03 GPIO-16
25 26 27 28
SPISTE-A ADC-B2 EPWM-2A GND
GPIO-19 COMP1 (-VE) GP10-02
29 30 31 32
SPICLK-A GPIO-34 PWM1A-DAC GND
GPIO-18 (LED) (Filtered)
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Flash Programming

Flash Programming Basics

Flash Programming Basics
¢ The device CPU itself performs the flash programming
¢ The CPU executes Flash utility code from RAM that reads the Flash
data and writes it into the Flash
¢ We need to get the Flash utility code and the Flash data into RAM
FLASH |« CPU
Flash 1
lét(')lc'jtg -——— ->| Emulator |— >| JTAG |— ———————— >
7 RAM
______ >/RS232 - 3| SCI -->
=3 F .
———————————— > SPI - = > - !
Flash g /'
Data || ===========-= > 12 F-->3 8 |---
X 5
———————————— >l CAN --3 &
e > GPIO i— - = >
TMS320F2806x

Flash Programming Basics

¢ Sequence of steps for Flash programming:

Algorithm Function
1. Erase - Set all bits to zero, then to one
2. Program - Program selected bits with zero
3. Verify - Verify flash contents

¢ Minimum Erase size is a sector (8Kw or 16Kw)
¢ Minimum Program size is a bit!

¢ Important not to lose power during erase step:
If CSM passwords happen to be all zeros, the
CSM will be permanently locked!

¢ Chance of this happening is quite small! (Erase
step is performed sector by sector)
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Programming Utilities and CCS Flash Programmer

Flash Programming Utilities

¢ JTAG Emulator Based
+ Code Composer Studio on-chip Flash programmer
+ BlackHawk Flash utilities (requires Blackhawk emulator)
+ Elprotronic FlashPro2000
+ Spectrum Digital SDFlash JTAG (requires SD emulator)
+ Signum System Flash utilities (requires Signum emulator)
¢ SCI Serial Port Bootloader Based
+ Code-Skin (http://www.code-skin.com)
+ Elprotronic FlashPro2000
¢ Production Test/Programming Equipment Based
+ BP Micro programmer
+ Data I/O programmer
¢ Build your own custom utility
+ Can use any of the ROM bootloader methods
+ Can embed flash programming into your application
+ Flash API algorithms provided by TI

* Tl web has links to all utilities (http://www.ti.com/c2000)

CCS On-Chip Flash Programmer

+ On-Chip Flash programmer is integrated into the CCS debugger

5]
@ On-Chip Flash X

Key 6 (OxAES): | FFFF ~

o e b
On-Chip Flash (TMS320C28xx) (7 type fiter text
: Memory Map Key 5 (OxAES): | FFFF

Clock Configuraton GEL Fies Koy 4 oxaz): | P
OSCCLK (MHz): | 10 ERSH E (Oxag3): | FRRF
G Generic Debugger Options cmshe M
C280x Debugger Options CLKINDIV: C280x Debugger Optons Key 2 (OxAE2): [FFFF
PLLCR value: |16 PR
P key 0 (Oxaz0): | FFEF

(®Erase, Program, Ver

() Load RAM Only Frequency Test

Erase Sector Selecton
Sector A: (0x3F4000 - 0x3F 7FFF)
[¥] sector B: (0x3FD000 - 0x3F3FFF)
Sector C: (Ox3EC000 - Ox3EFFFF)

[start Frequency Test ] [End Frequency Test

Depletion Recovery

Sector D: {0x3E8000 - 0x3EBFFF)
[SEp——
Sector F: (0x3E0000 - Ox3E3FFF) Checks

[#] sector G: (0x30C000 - 0x3DFFFF)
Sector H: (0x3DB000 - 0x3DBFFF)

Flash Checksum:

QTP Chedsum:
Erase Flash
Calculate Checksum
Remember My Settings
v

v

+ Tools & On-Chip Flash
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Code Security Module and Password

Code Security Module (CSM)

¢ Access to the following on-chip memory is restricted:
0x000A80

Flash Registers

0x008000 1 5 HFSARAM (2Kw)
0x008800 11 HESARAM (IKw)
0x008C00 =5 555 ARAM (TKw)
0x009000 T3 55SARAM (4Kw)
0x00A000 T—Z 5 5SARAM (8Kw)
0x00C000 e

gxgwggg User OTP (1Kw)
x3D7 reserved

0x3D7C801T=A5FTGSC cal. data

0x3D7CCO d

0x3D8000 resenye
FLASH (128Kw)

Ox3F7FF8
0x3F8000 PASSWORDS (Bw)

¢ Datareads and writes from restricted memory are only
allowed for code running from restricted memory
¢ All other data read/write accesses are blocked:

JTAG emulator/debugger, ROM bootloader, code running in
external memory or unrestricted internal memory

CSM Password

0x3D8000

FLASH (128Kw) CSM Password
Locations (PWL)
Ox3F7FF8[ 128.Bit Password | Ox3F7FF8 - Ox3F7FFF

¢ 128-bit user defined password is stored in Flash

¢ 128-bit KEY registers are used to lock and unlock
the device
& Mapped in memory space 0x00 OAEO — 0x00 OAE7
¢ Registers “EALLOW” protected
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CSM Password Match Flow

Start

Flash device
secure after
reset or runtime

Do dummy reads of PWL
0x3F 7FF8 — Ox3F 7FFF

I

Device permanently locked

—>|

Write password to KEY registers
0x00 OAEO — 0x00 OAE7

(EALLOW) protected

Device unlocked

Correct Yes

password? User can access on-

chip secure memory
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Lab 4. Programming the Flash

» Objective

The objective of this lab is to program and execute code from the on-chip flash memory. The
TMS320F28069 device has been designed for standalone operation in an embedded system.
Using the on-chip flash eliminates the need for external non-volatile memory or a host processor
from which to bootload. In this lab, the steps required to properly configure the software for
execution from internal flash memory will be covered.

Lab 4. Programming the Flash

ADC on period match
using SOCA trigger every
20 ps (50 kHz)

Objective:

ePWM1 ADC %a;%ory
TB Counter ADCINAO | RESULTO

Compare 'g
Action Qualifier CPU copies §
connector [ result to o
wire i buffer during -
H ADC ISR - 2
: . £
ePWM2 triggering @ " g

ePWM2

¢ Program system into Flash Memory
¢ Learn use of CCS Flash Programmer
¢ DO NOT PROGRAM PASSWORDS

View ADC
buffer PWM
Samples

Code Composer l

Studio

> Procedure

Open the Project

1. A project named Lab4 has been created for this lab. Open the project by clicking on
Project - Import Existing CCS/CCE Eclipse Project. The “Import”
window will open then click Browse... next to the “Select search-directory” box.
Navigate to: C:\C28x\Labs\Lab4\Project and click OK. Then click Finish to

import the project.

2. Inthe Project Explorer window, click the plus sign (+) to the left of Lab4 to view
the project files. All Build Options have been configured for this lab. The files used in

this lab are:
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Adc.c Gpio.c
CodeStartBranch.asm Lab.h
Defaultlsr_3 4.c Lab 4.cmd
DelayUs.asm Main_4.c
EPwm.c Passwords.asm
F2806x_Defaultlsr.h PieCtrl.c
F2806x_GlobalVariableDefs.c PieVect.c
F2806x_Headers_nonBI0OS.cmd SysCtrl.c
Flash.c Watchdog.c

Link Initialized Sections to Flash

Initialized sections, such as code and constants, must contain valid values at device power-up.
Stand-alone operation of an F28069 embedded system means that no emulator is available to
initialize the device RAM. Therefore, all initialized sections must be linked to the on-chip flash
memory.

Each initialized section actually has two addresses associated with it. First, it hasa LOAD
address which is the address to which it gets loaded at load time (or at flash programming time).
Second, it has a RUN address which is the address from which the section is accessed at runtime.
The linker assigns both addresses to the section. Most initialized sections can have the same
LOAD and RUN address in the flash. However, some initialized sections need to be loaded to
flash, but then run from RAM. This is required, for example, if the contents of the section needs
to be modified at runtime by the code.

3. Open and inspect the linker command file Lab_4.cmd. Notice that a memory block
named FLASH_ABCDEFGH has been been created at origin = 0x3D8000, length =
0x01FF80 on Page 0. This flash memory block length has been selected to avoid
conflicts with other required flash memory spaces. See the reference slide at the end of
this lab exercise for further details showing the address origins and lengths of the various
memory blocks used.

4. InLab_4.cmd the following compiler sections have been linked to on-chip flash
memory block FLASH_ABCDEFGH:

Compiler Sections:

text .cinit .const .econst pinit .switch

Copying Interrupt Vectors from Flash to RAM

The interrupt vectors must be located in on-chip flash memory and at power-up needs to be
copied to the PIE RAM as part of the device initialization procedure. The code that performs this
copy is located in InitPieCtri(). The C-compiler runtime support library contains a
memory copy function called memcpy() which will be used to perform the copy.

5. Open and inspect InitPieCtrl() in PieCtrl _c. Notice the memcpy() function used to
initialize (copy) the PIE vectors. At the end of the file a structure is used to enable the
PIE.
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Initializing the Flash Control Registers

The initialization code for the flash control registers cannot execute from the flash memory (since
it is changing the flash configuration!). Therefore, the initialization function for the flash control
registers must be copied from flash (load address) to RAM (run address) at runtime. The memory
copy function memcpy() will again be used to perform the copy. The initialization code for the
flash control registers InitFlash() is located in the Flash. c file.

6. Open and inspect Flash.c. The C compiler CODE_SECTION pragma is used to place
the InitFlash() function into a linkable section named “secureRamFuncs”.

7. The “secureRamFuncs” section will be linked using the user linker command file
Lab_4.cmd. Openand inspect Lab_4.cmd. The “secureRamFuncs” will load to
flash (load address) but will run from L4SARAM (run address). Also notice that the
linker has been asked to generate symbols for the load start, load end, and run start
addresses.

While not a requirement from a MCU hardware or development tools perspective (since
the C28x MCU has a unified memory architecture), historical convention is to link code
to program memory space and data to data memory space. Therefore, notice that for the
L4SARAM memory we are linking “secureRamFuncs” to, we are specifiying “PAGE
= 0” (which is program memory).

8. Open and inspect Main_4._c. Notice that the memory copy function memcpy() is being
used to copy the section “secureRamFuncs”, which contains the initialization
function for the flash control registers.

9. The following line of code in main() is used call the InitFlash() function. Since
there are no passed parameters or return values the code is just:

InitFlash(Q);

at the desired spot in main().

Code Security Module and Passwords

The CSM module provides protection against unwanted copying (i.e. pirating!) of your code from
flash, OTP memory, and the LO, L1, L2, L3 and L4 RAM blocks. The CSM uses a 128-bit
password made up of 8 individual 16-bit words. They are located in flash at addresses Ox3F7FF8
to Ox3F7FFF. During this lab, dummy passwords of OxFFFF will be used — therefore only
dummy reads of the password locations are needed to unsecure the CSM. DO NOT PROGRAM
ANY REAL PASSWORDS INTO THE DEVICE. After development, real passwords are
typically placed in the password locations to protect your code. We will not be using real
passwords in the workshop.

The CSM module also requires programming values of 0x0000 into flash addresses 0x3F7F80
through 0x3F7FF5 in order to properly secure the CSM. Both tasks will be accomplished using a
simple assembly language file Passwords.asm.

10. Open and inspect Passwords.asm. This file specifies the desired password values
(DO NOT CHANGE THE VALUES FROM 0xFFEFF) and places them in an initialized
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section named “passwords”. It also creates an initialized section named “csm_rsvd”
which contains all 0x0000 values for locations 0x3F7F80 to 0x3F7FF5 (length of 0x76).

11. Open Lab_4.cmd and notice that the initialized sections for “passwords” and
“csm_rsvd” are linked to memories named PASSWORDS and CSM_RSVD,
respectively.

Executing from Flash after Reset

The F28069 device contains a ROM bootloader that will transfer code execution to the flash after
reset. When the boot mode selection is set for “Jump to Flash” mode, the bootloader will branch
to the instruction located at address Ox3F7FF6 in the flash. An instruction that branches to the
beginning of your program needs to be placed at this address. Note that the CSM passwords
begin at address 0x3F7FF8. There are exactly two words available to hold this branch
instruction, and not coincidentally, a long branch instruction “LB” in assembly code occupies
exactly two words. Generally, the branch instruction will branch to the start of the C-
environment initialization routine located in the C-compiler runtime support library. The entry
symbol for this routine is _c_int00. Recall that C code cannot be executed until this setup routine
is run. Therefore, assembly code must be used for the branch. We are using the assembly code
file named CodeStartBranch.asm.

12. Open and inspect CodeStartBranch.asm. This file creates an initialized section
named “codestart” that contains a long branch to the C-environment setup routine.
This section has been linked to a block of memory named BEGIN_FLASH.

13. In the earlier lab exercises, the section “codestart” was directed to the memory
named BEGIN_MO. Open and inspect Lab_4.cmd and notice that the section
“codestart” will now be directed to BEGIN_FLASH. Close the inspected files.

On power up the reset vector will be fetched and the ROM bootloader will begin execution. If
the emulator is connected, the device will be in emulator boot mode and will use the EMU_KEY
and EMU_BMODE values in the PIE RAM to determine the bootmode. This mode was utilized
in an earlier lab. In this lab, we will be disconnecting the emulator and running in stand-alone
boot mode (but do not disconnect the emulator yet!). The bootloader will read the OTP_KEY
and OTP_BMODE values from their locations in the OTP. The behavior when these values have
not been programmed (i.e., both OXFFFF) or have been set to invalid values is boot to flash
bootmode.

Build — Lab.out

14. Click the “Bui 1d” button to generate the Lab . out file to be used with the CCS Flash
Programmer. Check for errors in the Problems window.

Programming the On-Chip Flash Memory

In CCS the on-chip flash programmer is integrated into the debugger. When the program is
loaded CCS will automatically determine which sections reside in flash memory based on the
linker command file. CCS will then program these sections into the on-chip flash memory.
Additionally, in order to effectively debug with CCS, the symbolic debug information (e.g.,
symbol and label addresses, source file links, etc.) will automatically load so that CCS knows
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where everything is in your code. Clicking the “Debug” button in the “CCS Edit Perspective”
will automatically launch the debugger, connect to the target, and program the flash memory in a
single step.

15.

Program the flash memory by clicking the “Debug” button (green bug). (If needed,
when the “Progress Information” box opens select “Detai ls >>” in order to watch
the programming operation and status). After successfully programming the flash
memory the “Progress Information” box will close.

Running the Code — Using CCS

16.

17.

18.

19.

20.

21.

22.

Reset the CPU using the “Reset CPU” button or click:
Run - Reset - Reset CPU

The program counter should now be at address 0x3FF75C in the “Disassembly” window,
which is the start of the bootloader in the Boot ROM. If needed, click on the “View
Disassembly..” button in the window that opens, or click View -> Disassembly.

Under Scripts on the menu bar click:

EMU Boot Mode Select - EMU_BOOT_FLASH.

This has the debugger load values into EMU_KEY and EMU_BMODE so that the
bootloader will jump to "FLASH" at address Ox3F7FF6.

Single-Step by using the <F5> key (or you can use the Step Into button on the
horizontal toolbar) through the bootloader code until you arrive at the beginning of the
codestart section in the CodeStartBranch.asm file. (Be patient, it will take about
125 single-steps). Notice that we have placed some code in CodeStartBranch.asm
to give an option to first disable the watchdog, if selected.

Step a few more times until you reach the start of the C-compiler initialization routine at
the symbol _c_int0O0.

Now do Run = Go Main. The code should stop at the beginning of your
main()routine. If you got to that point succesfully, it confirms that the flash has been
programmed properly, that the bootloader is properly configured for jump to flash mode,
and that the codestart section has been linked to the proper address.

You can now run the CPU, and you should observe the LED on the controlSTICK
blinking. Try resetting the CPU, select the EMU_BOOT_FLASH boot mode, and then
hitting run (without doing all the stepping and the Go Main procedure). The LED should
be blinking again.

Halt the CPU.

Terminate Debug Session and Close Project

23.

24.

Terminate the active debug session using the Terminate button. This will close the
debugger and return CCS to the “CCS Edit Perspective” view.

Next, close the project by right-clicking on Lab4 in the Project Explorer window
and select Close Project.
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Running the Code — Stand-alone Operation (No Emulator)
25. Close Code Composer Studio.
26. Disconnect the controlSTICK from the computer USB port.
27. Re-connect the controlSTICK to the computer USB port.

28. The LED should be blinking, showing that the code is now running from flash memory.

End of Exercise
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Lab 4 Reference: Programming the Flash

Flash Memory Section Blocks
origin =
0x3D 8000,
FLASH
length = Ox1FF80
page = 0 Lab_4.cmd
SECTIONS
{
OX3F7F80|  cgM_RSVD codestart :> BEGIN_FLASH, PAGE =0
length = 0x76 passwords :> PASSWORDS, PAGE =0
page =0 csm_rsvd > CSM_RSVD, PAGE=0
Ox3F 7FF6|  BEGIN_FLASH }
length = 0x2 \_//_
page =0
Ox3F 7FF8|  PASSWORDS
length = 0x8
page =0

Startup Sequence from Flash Memory

-
-
-
-

0x3D 8000 | k) —C_int00 | 2800 mLlib”

— Ox3F7FF6 [ 1B
________ —C_int00 — G) “user” code sections
Passwords (8w) main ()

U R
® e
0x3F 8000 | Boot ROM (32Kw) AN }

Boot Code AN
Ox3F F75C N

{SCAN GPIO} @ N
BROM vector (32w) AN
0x3F FFCO Ox3F F75C —

RESET
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The Next Step...

Training

C2000 MCU Multi-day Training Course

|n-depth hands-on - Direct Memory Access (DMA)
T MS320 F28069 Design - Control Law Accelerator (CLA)
and Periphera| - Viterbi, Complex Math, CRC Unit (VCU)
Training - System Design

TMS320F2806x Workshop Outline

- Architectural Overview

- Programming Development Environment
- Peripheral Register Header Files

- Reset and Interrupts

- System Initialization

- Analog-to-Digital Converter

- Control Peripherals

- Numerical Concepts and Igmath

- Communications
- DSP/BIOS
- Support Resources

controlSUITE

Texas Instruments controlSUITE

Pl ﬁ‘ control SUITE
‘ Devices
,F Kits
g Libravies
@ Update
Application Notes

3 Training and Support

w:3LINS|043U0D

=/ Datasheets and Guid

P )

Bs

s s Code Composer Studia IDE

controlSUITE™

controlSUITE™

Comprehensive. Intuitive, Optimized. Real world software for real-time control,

controlSUITE™ Software

' Comprehensive. Intuitive. Optimized

= Solutions for every design stage
* Unique real-time control IP

m » Download

on

5 .
== it
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controlSUITE™ Libraries
Texas Instruments controlSUITE
Gul exclusivly powered by emossnans
. ﬁj controlSUITE ——
Libraries
0 f’ Devices l a e .
=] A :
3‘ ;F Kits X o
3 g Libraries i; b
n @ Update o
cC The contralSUITE installation provides several different libraries, ranging from general-purpose Math and 1QMath libraries
=/ 4G to specialized DSP libraries as well as various Application libraries. Also availble are Utilities such as Flash APl and Boot
: =5/ Datasheets and Guides ROM Source Code.
I'I:I' Application Notes ¥ App Library - Motor Control
= ¥ App Library - Digital Power
a Training and Suppert ¥ App Library - PMBus over 12C
zﬂ Developer Network ¥ Math Library - Fixed Point (IQmath)
& ¥ Math Library - CLA
¥ #/ CodeComposerStudoBE & Math Library - Floating Point
&R % DSP Library - Fixed Point
% DSP Library - Floating Point
¥ DSP Library - VCU
¥ DSP Library - Signal Generation
v Utilities - Flash API
¥ Utilities - Boot ROM
¥ Utilities - HRCAP Calibration Library
search - @

+ Part Number:
+ TMDXDOCK28069
¢ TMDSDOCK23035 + Breadboard areas

+ TMDSDOCK28027
+ TMDSDOCK28335

C2000 Experimenter’s Kits

F28069, F28035, F28027, F28335, F2808

¢ Experimenter Kits include

+ F28069, F28035, F28027, F28335 or

F2808 controlCARD
+ USB docking station

hardware details

+ C2000 Applications Software CD
with example code and full

¢ Code Composer Studio v5

¢ Docking station features
¢ Access to controlCARD signals

¢ Onboard USB JTAG Emulation
& JTAG emulator not required

+ TMDSDOCK2808

¢ Available through Tl authorized
distributors and the Tl eStore
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C2834x Experimenter’s Kits

C28343,C28346

¢ Experimenter Kits include
¢ C2834x controlCARD
¢ Docking station

¢ C2000 Applications Software CD
with example code and full
hardware details

¢ Code Composer Studio v5
¢ 5V power supply

¢ Docking station features
+ Access to controlCARD signals
+ Breadboard areas

& JTAG emulator required — sold
separately

¢ Available through Tl authorized
distributors and the Tl eStore

4 Part Number:
+ TMDXDOCK28343
+ TMDSDOCK28346-168

F28335 Peripheral Explorer Kit

¢ Experimenter Kit includes
¢ F28335 controlCARD
+ Peripheral Explorer baseboard

+ C2000 Applications Software CD with
example code and full hardware details

¢ Code Composer Studio v5

¢ Peripheral Explorer features
¢ ADC input variable resistors
+ GPIO hex encoder & push buttons
+ eCAP infrared sensor
+ GPIO LEDs, 12C & CAN connection
+ Analog I/O (AIC+McBSP)

¢ Onboard USB JTAG Emulation
& JTAG emulator not required

¢ Available through Tl authorized

distributors and the Tl eStore

TMDSPREX28335
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+ Part Number:
+ TMDX28069USB
+ TMDS28027USB

C2000 controlSTICK Evaluation Tool

F28069, F28027

¢ Low-cost USB evaluation tool
4 Onboard JTAG Emulation

& JTAG emulator not required
¢ Access to controlSTICK signals

¢ C2000 Applications Software
CD with example code and full
hardware details

¢ Code Composer Studio v5

¢ Available through Tl authorized
distributors and the Tl eStore

*

C2000 controlCARD Application Kits

Developer’s Kit for — Motor Control,
PFC, High Voltage, Digital Power,
Renewable Energy, LED Lighting, efc.
Kits includes

+ controlCARD and application specific
baseboard

+ Full version of Code Composer
Studio v5

Software download includes

+ Complete schematics, BOM, gerber
files, and source code for hoard and
all software

+ Quickstart demonstration GUI for
quick and easy access to all board
features

+ Fully documented software specific to
each kit and application

See www.ti.com/c2000 for other kits
and more details

Available through Tl authorized
distributors and the Tl eStore
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C2000 Workshop Download Wiki
C2000 Workshop Download Wiki

& Login/create account

Page Discussion Read View source  View history [(Go ] [ Search
Hands-On Training for T| Embedded Processors

{I Texas
INSTRUMENTS

Hands-On Training for T| Embedded Processors Translate this page to |8 - Deutsch [¥| [Transtate

Navigation Ti's Technical Training Organization conducts hands-on |E
training for Tl er processors at various
vorldwide locat

find complete course
descriptions. locations, dates. and enrollment information hare d?
On demand and live training can also be found at Tl eTechDays & You can sign up for the live events which are typically scheduled 2-3 times per year

On the Tl training site. you can find specific workshop locations/dates using the left-hand navigation links. Select “By Type” and then select sither “1.Day
Workshops" or "Muti-Day Workshops” ta get a complete list of training available. Click on the "Register Now” button. or one of the indridual
Register” buttons to enroll in a workshop

f you would like to review specific workshop matarials on your own, you can download the files using the links balow

C2000™ 32-bit Real-Tima MCU Training

C2000™ One-Day Workshop

p agenda
Online matenals and labs

€2000™ Multi-Day Workshop

€2000 * Multi-Day Warkshop agenda, locations, and schedule @
Toolbox Online materials labs

Whatlinks here C2000™ Archived Workshops

The archived workshops are for F24xx. F28xx. and F28xxx one-day and multi-day workshops The matenials. Iabs and solutions can be found here
€2000 archived workshops

http://processors.wiki.ti.com/index.php/Training

Development Support

For More Information . ..

¢ USA — Product Information Center (PIC)
& Phone: 800-477-8924 or 972-644-5580
¢ E-mail: support@ti.com

¢ Tl E2E Community (videos, forums, blogs)
< http://e2e.ti.com

¢ Embedded Processor Wiki

& http://processors.wiki.ti.com

¢ Tl Training

< http://www.ti.com/training
¢ Tl eStore

¢ http://estore.ti.com
¢ Tl website

& http://www.ti.com
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